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Variations on a Theme:
Physical Computing

by Ralph P. Lano, 1. Edition

For whom
This book is intended for Bachelor students in their first or second semester.  It should be used as part of a
lecture, since it is probably not suited for self-study.  If you are interested to learn about Arduinos and if
you would like to understand how to build circuits that work together with those Arduinos, then this book
should be useful to you.  Very little to no previous knowledge is required.

From whom
Since  2011,  I  have  been  Professor  of  Internet  Programming  and  Multimedia  Applications  in  the
MediaEngineering program at the Nuremberg Institute of Technology. From 2003 to 2010 I was Professor
of Software Engineering and Multimedia Applications at the University of Applied Sciences Hof, and
from 2010 to 2011 Professor of Media and Computing at HTW Berlin. I received my doctorate in 1996
from the University of Iowa on the subject 'Quantum Gravity: Variations on a Theme'. From 1996 to 1997
I was Postdoctoral Research Associate at the Centre for Theoretical Studies of the Indian Institute of
Science.  From 1997  to  2003  I  worked  at  Pearson  Education  and  later  at  Siemens  AG in  software
development and project management.

About what
Physical Computing is all around us.  Our smartphones, our cars, our washing machines, all are examples
of physical computing.  Even our toaster has become smart these days.  Smart meaning controlled by a
micro-controller, and physical computing meaning some electronic components controlled by a micro-
controller.  If  these  electronic  components  are  electric  motors,  magnets  or  other  actuators,  then  the
electronic becomes physical, meaning something moves.  But physical also means measuring things like
temperature,  sound,  and  light.  We want  to  learn  about  all  these,  about  electronics,  about  electronic
components, and about micro-controllers.

We start with a little bit of history, not because usually that's what one does, but because many of the
concepts and components become really easy to grasp and understand.  After having seen some of the
origins, we then learn about simple electric circuits and simple electronic components.   We get to know
batteries, switches, resistors, capacitors and inductors.  And we will briefly hear about Ohms law and
Kirchhoff's circuit laws.  We also get to learn how to use the circuit simulator.  Then the active electronic
components follow, such as diodes, LEDs, and transistors.  We learn about the different type of diodes
that there are and what they are used for.  We get to know transistors, bipolar and field-effect, and how to
use them as switches and as amplifiers.  We get to see the multivibrators, especially the astable and the
bistable, and learn why they are so important for computers.  After these introductory chapters, we have
enough of a foundation to do some real physical computing.  We will use an Arduino and connect it with
the different electronic components we learned about in the previous chapters.

How
does one learn to play the piano? Not by watching or listening. It's the same with everything else: you
have to practice a lot! And the more you practice, the better you become at it. That is why, after a brief
introduction  to  the  core  material  we  have  lab-section,  which  are  all  about  trying  things  out,  doing
experiments.  The course as I teach it, consists of three components: the lecture, the labs and assignments.
The lecture is two hours per week and corresponds to the first  part of each chapter in the book. We
complete one chapter in about two to three weeks. In the labs, which also last two hours a week, we then
devote ourselves to the experiments. We manage between two or three of the experiments per lab. In the
labs, the students work in teams, usually in pairs, to help each other.  Before being allowed to take part in
the labs, the students have to show that they prepared the labs through their assignments.
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Where
can I find the examples? You can find them on the website of the book: www.VariationsOnATheme.eu.
Also updates, links to the development environment, and the book in electronic form can be found there.
The book in printed form is available on Amazon, in black and white.

May I
use the examples, or copy the book? This material is licensed under Creative Commons Attribution -
Non-commercial - Distribution under Equal Terms 4.0 International (CC-BY-NC-SA 4.0). That is, you
may reproduce and redistribute the material in any format or medium, remix the material, modify it, and
build upon it. However, you must provide appropriate copyright and other proprietary notices, include a
link to the license, and indicate whether any changes have been made. This information may be provided
in  any  reasonable  manner,  but  not  in  such  a  way  as  to  create  the  impression  that  the  Licensor  is
specifically endorsing you or your use. You may not use the material for commercial purposes. And if you
remix, modify, or otherwise directly build upon the material, you may distribute your submissions only
under the same license as the original, and you may not use any additional clauses or technical procedures
that legally prohibit others from doing anything that the license permits. To view a copy of this license,
visit http://creativecommons.org/licenses/by-nc-sa/4.0/.

Why
The Physical Computing class consists of a 2h lecture and a 2h lab.  Hence we needed to focus on the
essentials.  There are many books out there, most of them either have to much on electronics, or focus
only on the Arduino.  I wanted a small book, that has the minimum of what is needed to understand the
Arduino cricuits in the last chapter, assuming next to no previous knowledge.  And, I wanted the students
to record their experiments like it would be done in a real industrial laboratory notebook.  I think this is an
important lesson.

Who helped?
I would like to thank Paul Falstad for the Electronic Circuit Simulator which he graciously put under an
opensource license.  Without  his simulator this  book would not  exist.  I  would also like to thank the
Wikipedia and its thousands of authors.  It makes it so incredibly easy to access and use information.  In
addition, I would like to thank Johannes Brendel and Daniel Baer for their patience and support during
the first iteration of this class.  Their invaluable feedback made this project orders of magnitude better,
than what it would have been.  The book should not, but most likely will contain errors.  If you find one,
please let me know.  Be warned that this is only the second iteration, hence I assume it will contain quite a
few inconsistencies.  I am not very proud of it, because it was created in a hurry, it had to get out there by
October 10th, to be used for the fall term.  So it did.

References
[1] Erik Bartmann, Die elektronische Welt mit Arduino entdecken, O'Reilly Verlag, 2011
[2] Electronics All-in-One For Dummies, For Dummies, by Doug Lowe
[3] Arduino Cookbook: Recipes to Begin, Expand, and Enhance Your Projects, O'Reilly, by M. Margolis, 
B. Jepson, N.R. Weldin
[4] ITP Physical Computing, https://itp.nyu.edu/physcomp/
[5] Elektronik Kompendium, https://www.elektronik-kompendium.de/
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Labs and Safety
I am a strong  believer in learning by doing.  However, doing is sometimes a little more dangerous than
not doing.  That  is why we have to talk about  lab safety before we start.   We are only dealing with
batteries and some static electricity, nothing that you have not encountered before.  But shortcircuiting a
battery can cause a fire, or touching your precious iPhone or laptop, while statically charged, might be the
end of it.  That is why we need to be aware of lab safety.

Safety
Safety comes first.  Some of the experiments can be dangerous or harmful, they are marked with the label
"Instructor".  Those are potentially harmful experiments, that should only be done by your instructor or
under  the  direct  supervision of  your  instructor.  Especially,  people  with a  heart  condition,  should be
extremely careful.  Please let your instructor know if you have or suspect a heart condition. 

We will only be working with 9 volt batteries, and those are completely safe, if used properly.   Dangerous
is anything that has to do with regular electric outlets of 110 or 220 volts: even currents as small as 50 to
100 mA can trigger cardiac arrest [1].  Also dangerous could be  static electricity [3].  So again, any of
those experiments marked with "Instructor" should be done by your instructor.   If through your actions
you put others or yourself in danger, disciplinary measures will be administrated.  Never perform any
unauthorized experiments.

Although a 9V battery may seem pretty harmless, if used in the wrong way, it can cause a fire or even
explode.  Hence, always follow these simple rules:

• if it starts smelling, disconnect the battery! 
• if it starts smoking, disconnect the battery! 
• if the battery gets hot, disconnect the battery! 
• never leave electric circuits  unattended,  always make sure you disconnect  the  battery,  before

leaving the table or the room. 

If any of the above occurs, recheck your circuit.  Have somebody else take a look at.  If you don‘t find a
mistake, totally disassemble it and start anew.

In addition being harmful to people, electricity can also be harmful to equipment.  We expect you to
perform all experiments in a serious and professional manner.  Some of the equipment is rather sensitive. 
You are expected to treat all the equipment provided with care. 

Preparations
In the labs you will work in teams of two students.  You will perform experiments and write down the
results  of  these experiments in your laboratory notebook.  Labs will  require preparations beforehand,
usually given as an assignment.  In case you have not done the preparation, you are not permitted to
perform the lab.  Your instructor will check that you made the neccessary preparations before you are
allowed to perform any of the experiments.  At the end of the labs, your instructor will wittness and sign
your entries, like it would be done in a real industrial laboratory.  Your laboratory notebook is the only
proof that you performed the labs, hence do not loose it.

Before attempting to perform any of the experiments in this lab, you need to have done the following
preparations beforehand:

• You should know what to do in case of an emergency [2]. 
• You should know about the dangers of  static electricity to people and equipment.  (Look for

"dangers of electrostatics" on Google.) 
• You should know what a short-circuit is, and why it is dangerous. 

In addition you should familiarize yourself with the laboratory notebook how to set it up, how to use it,
and why it is important.  For this please read [4,5].
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Labs and Safety

Laboratory Notebook
You are expected to keep notes of all the experiments you perform in your laboratory notebook.   To see
examples on how this is done properly, you should read reference [4].   We want to follow reference [7]
for the outline of our experiments, which means, all experiments should include:

1. Title:  The title should be short and descriptive. 
2. Hypothesis:  Briefly describe the intended experiment and what you expect the outcome to be. 
3. Materials:  List the materials needed to perform this experiment. 
4. Procedure:  In the procedure you describe the experiment in a step by step fashion.   This should

be brief, but contain enough information, such that somebody else, with your knowledge, can
repeat the experiment and verify it. 

5. Observations & Results:  What did you observe and what were the results of the experiment? 
Not all experiments work perfectly, sometimes they don't work at all.  Truthfully describe your
observations. 

6. Conclusion:  You started out with a hypothesis, in the conclusion section you either verify or
falsify your hypothesis.  In the scientific method [8], both are equally important. 

In  case  you are  interested  to  learn  how laboratory  notebooks  are  used  in  industry,  we  refer  you to
references [5,6].

Further Reading
You first must read reference [1] on "Electrical cardiac injuries".  Even currents as small as 50 to 100 mA
can trigger cardiac arrest.  Also take a look at table 1 in this reference.   In addition, it is required that you
read reference [2] on what to do in case of an emergency.  If you care about your equipment, like your
smartphone and your laptop, then reading the article on "Static electricity and people" [3] might be very
enlightening.  For German readers the question why the Wikipedia has no German article for the scientific
method [8] should be interesting to ponder about.

References
[1] Electrical cardiac injuries: current concepts and management, Victor Waldmann, Kumar Narayanan, 
Nicolas Combes, Daniel Jost, Xavier Jouven, Eloi Marijon, European Heart Journal, Volume 39, Issue 16,
21 April 2018, Pages 1459–1465, https://academic.oup.com/eurheartj/article/39/16/1459/3746021
[2] Emergency Response Chapter 3 - Electrical Safety, www.allaboutcircuits.com/textbook/direct-  current  /  
chpt-3/emergency-response/
[3] Static electricity and people, Niels Jonassen, https://incompliancemag.com/article/  static  -electricity-  
and-people/
[4] Instructions for Using Your Laboratory Notebook, IW Hunter and BJ Hughey, web.mit.edu/me-
ugoffice/communication/labnotebooks.pdf
[5] How to Start–and Keep–a Laboratory Notebook, www.iphandbook.org/handbook/ch08/p02/
[6] Guidelines for Keeping a Laboratory Record, David R. Caprette, abacus.bates.edu/~ganderso/biology/
re  source  s/Lab_notebook_guidelines_DR_Caprette.pdf  
[7] How to record an experiment, elementalscience.com/blogs/news/how-to-record-an-experiment
[8] Scientific method, https://en.wikipedia.org/wiki/Scientific_method
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Introduction

Physical  Computing [1]  is  all  around us.  Our smartphones,  our  cars,  our washing machines,  all  are
examples  of  physical  computing.  Even  our  toaster  has  become  smart these  days.  Smart  meaning
controlled  by  a  microcontroller  [2],  and  physical  computing  meaning  some  electronic  components
controlled by a microcontroller.  If these electronic components are electric  motors, magnets or other
actuators, then the electronic becomes physical, meaning something moves [3].  But physical also means
measuring things like temperature, sound, and light.  We want to learn about all these, about electronics,
about electronic components, and about microcontrollers.

.
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Introduction

A Brief History of Electricity
Electricity was known to humans for a long time [4].  The first  one's were the
ancient  Egyptians,  already in 2750 BCE they were writing about  shocks from
electric fish.  The ancient Arabs were the first to make the connection between
electric  fish  and lightning.  Ancient  Mediterranean cultures  knew that  rubbing
amber with a cat's fur can attract small objects such as feathers.

Then  in  the  17th  century  things  started  to  get  interesting.  In  1663  Otto  von
Guericke  invented  the  friction  machine,  which  produced  static electricity  [5]. 
About eighty years later,  in 1745,  Ewald Georg von Kleist,  and independently
Pieter  van Musschenbroek,  invented what  is  now called the  Leyden jar,  which
could store static electricity [6].  Another fifty years later, in 1791, Luigi Galvani
connected metal cable to the nerves and muscles of a frog, and was startled when
they moved [7].  Alessandro Volta repeated Galvani's experiments, and by refining
them invented the  Voltaic pile [8].  This was the first  battery providing constant
current.  And the rest is history as they say [9].

What is Electricity?
From this brief history lesson we learn, that electricity has fascinated people for
thousands of  years.  Over  those  years  people  tried to  get  an  understanding,  and  they  came up with
analogies, but also new concepts and ideas.  The most important ones are  charge,  current and voltage. 
First people identified charges.  There are two kinds: negative and positive [10].  Electrons, for instance
carry negative charge, and protons carry positive charge.  Then people realized that these charges can
move.  And that is what we call a  current: a  current is moving charges, like water  currents are moving
water.  If there are no charges moving, then there is no current.  And finally, what makes these charges
move?  That is what voltage is.  Only if there is a voltage then charges will move.  That is similar to water
will move only downhill, if it is flat, water will not move.

Simple Analogy
If you want an analogy, then think of a toy wooden railroad
track.  The little cars are like the charges.  If you put a car on
a track, and the track is flat, the car will just sit there.  No
current flowing.  But if the track is inclined, then the little
cars will move down the track.  Hence we have a  current. 
And the height, is the potential, in this case the gravitational
potential, in the case of electrons the electric potential.  And
another name for electric potential is  voltage.  By the way,
the track for our cars, is like a piece of cooper wire for the charges.

With analogies we always have to be a little careful:  it is true, that having more cars, is equivalent to
having a higher current.  However, if in our train example, we make the slope steeper, then the cars will
move faster.  Well, for electrons there is no faster.  They always move pretty much with the same speed
(about half the speed of light).  Therefore analogies are helpful, but one needs to know their limits.  For
most of what we do, the railroad track analogy will work fine.

8
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Introduction

Conductors of Electricity
One more thing we need to talk about, and that is  conductors [11].  Like in
classical  music,  there  are  good  conductors  and  bad  conductors.  Usually
metals are good  conductors, whereas glass, ceramics, wood, and plastic are
bad conductors of electricity.  Bad conductors are also called insulators.  Also
air, tends to be a poor conductor.  For water it depends: destilled water is not a
good conductor, but add some salt and it becomes a decent conductor. 

There is one more type of  conductor, the  semi-conductor [12].  Silicon and
germanium are semi-conductors.  As their name suggests, they are kind of in
between conductors and insulators.

How can we distinguish conductors from semi-conductors? Well, there is an
interesting  temperature dependence of the conductivity:  the conductivity of
conductors reduces as  temperature increases, whereas for semi-conductors it is the opposite way.  This
may seem pretty useless, but if you consider what the difference the invention of the transistor made, you
might think differently about this seemingly useless property.

There is also something called super-conductors, but it is forbidden to talk about those [13].

Review
We took a very brief look at the history of electricity, we learned about charge, current and voltage, and
we learned about conductors.  We saw that there are analogies, but also noticed, that we have to be a little
careful with analogies.  In the next section, the labs, we will repeat some of those historic experiments
with simple household items.

Labs
Before we start with our first lab section, we need to talk about safety.   In case you haven't, you must read
the chapter on Labs and Safety before proceeding.  You will have to sign a statement, stating that you
obey by the rules set forth therein.

In the labs you will work in teams of two students.  You will perform experiments and write down the
results of these experiments in your laboratory notebook.  At the end of the labs, your instructor will sign
and  witness  your  entries.  Laboratory  notebooks  are  used  in  industrial  labs  as  a  primary  record  of
research.  It can have an essential role in protecting any intellectual property that comes from the research
[17].

Preparations
Labs will require preparations beforehand, usually given as an assignment.  In case you have not done the
preparation, you are not permitted to perform the lab.

Before attempting to perform any of the experiments in this lab, you need to have done the following
preparations beforehand:

• You should know what to do in case of an emergency [14]. 
• You should know about the dangers of  static electricity to people and equipment.  (Look for

"dangers of electrostatics" on Google.) 
• You should know what a short-circuit is, and why it is dangerous. 

In addition you should familiarize yourself with the laboratory notebook, how to set it up, how to use it,
and why it is important.  For this please read [15,16].

9



Introduction

Note to Instructors
Equipment needed for the labs in this chapter: alligator clips, aluminum foil, balloons, batteries (1.5V and
9V), coil, copper wire, electroscope, graphite, hot water, ice cubes, iron nails, Leyden jar, lighter, multi-
meter, potato/lemon, saran wrap, silicon, small iron nail or needle, small magnet, small solar cell, thread,
PVC pipe, towel, blue LED, resistor, anti-slug copper strip.

Experiments
In this lab we will learn some of the physical principles behind electric components.   We actually build a
whole bunch ourselves: we learn how to make our own  resistor (graphite),  capacitor (alu+saran), and
inductor (wire+nail).  We also learn how to use a multi-meter to measure  voltage,  current,  resistance,
capacitance, and inductance.

1. Balloons
Equipment: children’s balloons, t-shirt.

One  of  the  simplest  demonstration  of  static electricity  is  with  children’s
balloons.  Simply  rub  the  balloon  on  a  synthetic  cloth,  like  a  t-shirt  for
instance, and then hold it to the wall.  The balloon should stick to the wall for
a little while.  If you heave feathers, small Styrofoam pieces or small pieces of
paper, they should be attracted to the balloon. 

Question: Why is that?

2. PVC Pipe (Instructor)
Equipment: PVC pipe, towel.

IMPORTANT:  No  computers,  smart  phones,  smart  watches  or  any  other
electronic devices should be near static electricity!

Since most of us do not have cat fur and/or amber at our disposal, nowadays
we use towels and PVC pipes instead.  Basically the same idea as with the
balloon, but a little more effective is the PVC pipe.  You need a PVC pipe and
a towel.  Rub the PVC pipe with the towel for a few times.  Some techniques
are more efficient than others.  You will notice that small pieces of paper get
attracted or repelled by the PVC pipe. 

3. Electroscope (Instructor)
Equipment: electroscope, balloons, PVC pipe, battery, towel.

IMPORTANT:  No computers,  smart  phones,  smart  watches or  any other
electronic devices should be near static electricity!

In our first two experiments we saw how to create static electricity.  But how
do we measure electricity [18]?  Well, you can use little pieces of paper and
see if they get attracted.  Or you could touch the electric fish, or touch the
PVC  pipe  and  get  an  electric  shock,  not  recommended.  That  is  at  the
minimum unpleasant,  and depending on the  voltage even dangerous.  You
could also use frog legs, if you happen to have them handy. 

Alternatively, we can use an electroscope.  With simple household items, we
can actually build our own. Use the balloon or the towel and PVC pipe to
generate  static electricity.  Try to connect  a  battery to the electroscope.  Which of the three methods
creates the most static electricity?

10
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4. Leyden Jar
Equipment: electroscope, Leyden jar.

A Leyden jar [6] is basically a capacitor.  Like the electroscope, it is really easy to build our
own Leyden jar.  Take an empty plastic bottle, fill it with water, add a little salt and close it.
Through the lit you stick a nail, and finally wrap aluminum foil around it.  Once build, we can
use the multi-meter to measure the capacitance of our Leyden jar. 

5. Ground (Instructor)
Equipment: electroscope, Leyden jar, anti-slug copper strip.

It is time to learn about what electrical engineers refer to as "ground" [24].  You may want to
watch video [19] to learn a little more about ground.  If you repeat the above experiments with the PVC
pipe, the Leyden jar (and later the capacitor), with the aluminum foil being connected to ground, you will
notice that all the effects are significantly stronger.

I hope it is clear, that Mehdi Sadaghdar, also known on YouTube as ElectroBOOM [19], is an electrical
engineer.  That  means  he  knows  what  he  is  doing.  You  should  not  attempt  to  repeat  any  of  his
experiments!  Still they are very entertaining and instructional.

6. Measuring Voltage
Equipment: multi-meter, two 1.5V batteries.

Another way to measure electricty is with a voltmeter, or in our case a multi-
meter.  To get started we want to measure the voltages of batteries.  First, just
measure the  voltages individually, then connect two 1.5V batteries in series,
that means the plus of one 1.5V battery connected to the minus of the other
1.5V battery.  You can look at reference [20] if you need additional help.

7. Homemade Battery
Equipment: multi-meter, potato/lemon, aluminum foil, copper wire, alligator
clips, iron nail.

First, take aluminum and connect it to the multi-meter using alligator clips.
Then moisten your  fingers,  touch the aluminum and the other  lead of  the
multi-meter, and measure the voltage. Try this with different metals like iron
or copper. [21]

Second, stick a piece of copper wire and an iron nail into a potato or lemon. 
Measure the  voltage using the multi-meter.  Again use different metals, and
for each combination measure the voltage difference.  Does it make a difference if you use a potato or a
lemon?

Questions:

1. What other ways are there to create electricity? 
2. How do you know if a battery is full or empty? 
3. Assume you want to create a battery with a voltage of 1.1 volts.  Which metals would you use?

[22] 

Another interesting experiment is the Aluminum Air Battery [23].
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8. Resistance
Equipment: multi-meter, two hands.

Set your multi-meter to measure  resistance (Ohm).  Then hold the two leads
between your fingers, and see what  resistance your body has.  Now moisten
your fingers and repeat the experiment.  You should notice that the resistance
is less now. 

9. Conductance
Equipment: multi-meter, copper wire, coil, graphite, alligator clips.

Use your multi-meter to measure resistance.  First, start with a piece of copper
wire.  Take a  short piece and measure it.  Then use the coil and measure its
resistance.  According to Amazon, it is 280 meters long (all eight or only one
wire?). 

Second, use graphite pencil leads.  Take the following measurements:

• full length pencil leads 0.5mm 
• full length pencil leads 0.7mm 
• half length pencil leads 0.5mm 
• two half length pencil leads 0.5mm connected in series 
• two half length pencil leads 0.5mm connected in parallel 

Record their respective conductance.  Conductance is the inverse of resistivity. 

Question: What are the units of conductance?  How could you estimate the length of the above wire via
its resistance?

10. Resistor
Equipment: multi-meter, graphite, alligator clips.

Make your own resistor out of graphite pencil leads.  First, measure the resistance of the graphite in ohm. 
Then make your own resistor that has the  resistance of exactly 4 ohms. This is basically how a carbon
film resistor works.

Question: Could you also create a variable resistor?

11. Capacitor
Equipment: multi-meter, aluminum foil, saran wrap, blue LED, alligator clips,
9V battery.

Another way to build a capacitor is with aluminum foil and saran wrap.  Make
a sandwich, starting with a layer of saran wrap, followed by aluminum foil,
another layer of saran wrap, and another layer of aluminum foil.  Have two
thin pieces of additional aluminum foil stick out perpendicular for contacts to
the two different  layers of  aluminum foil.  Roll  the  whole  thing up like  a
burrito, but make sure that the two different aluminum foils don’t touch each other.  You may want to add
a third saran wrap layer, just to make sure. 

1. Use the multi-meter to measure capacitance of your "burrito". 
2. Charge your "burrito" with a 9V battery.  Connect the blue LED.  If connected in the right way, it

should light up briefly. 
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12. Coil
Equipment: multi-meter, coil, iron nails, compass.

A current flowing through a coil will generate a magnetic field.  Use the multi-
meter to measure the inductance of the coil in Henry.  Now place some iron
nails  in the inside of the coil  and measure the inductance again.   The coil
consists of eight wires.  Instead of using just one wire, use two and then three
wires, in series.  Each time measure the inductance. 

If  you  connect  the  coil  to  the  9V  battery,  you  can  create  a  measurable
magnetic  field.  If  your smartphone has a magnetic  sensor, you can use a
compass app to measure it.  You can also use an old school compass instead.

Question: How does the inductance depend on the number of turns? 

13. Homemade Ammeter (Instructor)
Equipment: coil, iron nails, thread, small iron nail or needle, small magnet.

Use the coil and add some nails in the inside.  Connect to 9V  battery only
briefly!  Measure  the  magnetic  field with  your  smartphone  (in  case  your
phone has a magnetic sensor).  Build your own ammeter by suspending a nail or a magnet from a tripod
just in front of the coil.  The nail should move, when the coil is connected to the  battery.  The more
current the more it will move.  This is basically how an analog ammeter works.  Next, your instructor
should use the multi-meter to measure the  current flowing through the coil (should be about 1 ampere,
which is a lot). 

Questions:

1. If your battery is rated 800mAh, how long will it take to drain your battery (assuming 1 ampere of
current is drawn)? 

2. Why do we add nails to the coil? 

Challenges

1. Conductor vs Semi-Conductor (Instructor)
Equipment: multi-meter, copper wire, graphite, silicon, hot water, ice cubes, lighter.

We have learned about  conductors, semi-conductors and insulators.  There is an interesting temperature
dependence for the different materials, which we can measure.  

First, we look at a  conductor, graphite (pencil lead).  Measure its  resistance using a multi-meter.  Next,
use  a  lighter  or  a  candle  to  heat  it  up a  little,  while  still  measuring  the  resistance.  Notice  that  the
resistance changes.  (You could also use any metal wire, just the effect is smaller).

Next, use silicon, a semi-conductor.  Put it in hot, distilled water and measure the resistance.  Then add
ice cubes (made from distilled water) to the water and observe what happens to the resistance.

Questions
1. Name three ways to generate electricity.

  
2. Which one has the higher resistance? 

• pencil lead of 0.7 mm thickness 
• pencil lead of 0.5 mm thickness.

13
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3. The galvanic cell corresponds to a 
• capacitor 
• resistor 
• transistor 
• battery.

4. Give an example each for a conductor, a semiconductor and an insulator.
  

5. Describe how you can build your own capacitor out of aluminum foil and saran wrap. 
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Electronic Components

In this chapter we learn about simple electric circuits and simple electronic components.   We get to know
batteries, switches, resistors, capacitors and inductors.  And we will hear about Ohms law and Kirchhoff’s
circuit laws.  Towards the end we will also see logic gates for the first, but not the last time.  We also need
to learn how to use the circuit simulator.
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Electronic Components
In the labs of the last chapters we met and made our first electronic components: resistors, capacitors and
coils.  In general, one distinguishes between:

• active components: such as batteries, transistors and diodes, 
• passive components: as there are resistors, capacitors and coils, among many others, and 
• electromechanical components: switches, motors, or fuses, for instance. 

In this chapter we will learn mostly about passive components. In what follows, we get to know all kinds
of electronic components [1], what they do and how they work, and how to connect them together to all
kinds of different circuits.

AC/DC
The Wikipedia says "AC/DC are an Australian rock band formed in Sydney in 1973 by Scottish-born
brothers Malcolm and Angus Young." [2].   You may never have heard of AC/DC (probably a good thing),
but you will hear a lot about DC in this class, and a little about AC.  DC stands for direct current, the type
of current that comes out of batteries.  AC stands for alternating current, the type that comes out of the
electrical outlets in your walls.  DC is a lot simpler and somewhat less dangerous than AC.  For now, we
will only deal with DC.

Electric Circuits
According to the thesaurus, the word circuit is a synonym for circle or cycle [3].  In electronics it refers to
a bunch of electronic components, such as batteries, switches and lamps connected together  with wires,
such that they form a cycle, i.e., there are no loose ends. 

As an example, consider what happens when you turn on your light at home.  We can represent this in a
circuit diagram, which would look something like the following:

battery, switch and lamp

In a  circuit  diagram we represent  each circuit  by its  circuit  symbol,  and wires are  depicted as  lines
connecting those symbols.  Usually, there is a circuit where the electricity comes from: here it is a battery,
at home it is AC coming from the electric outlet.  Then there is a light bulb and a switch.  Each has its
diagram.  They are all connected by wires.  And once you close the switch, the light goes on.
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Something we should be aware of is how crossings of wires are depicted in our diagrams.   The subtle
difference is the dot in the center of the diagram below.  It means that in the diagram to the left the wires
are not connected, whereas on the right they are.

wires not crossing wires crossing

We can simulate the behavior of electric circuits in a simulator, before we attempt to build the real thing. 
This is usually a good idea, just to make sure it is working.  We will learn about the simulator in the labs.

Battery
Let's first start with the battery.  There is all different kinds, with all kinds of voltages.  But
they all have two things in common: they produce DC, and they have a plus and a minus pole.

Now let's briefly talk about them electrons.  They are negatively charged, and they are all
located at the minus pole of the  battery.  That is why it is minus.  Now there is lots of electrons there
(really lots).  And electrons don't like each other very much, that is why they repel each other.  And if they
have a chance to get away, they will.  So, if we happen to take a piece of wire and connect the minus pole
of the battery to the plus pole, all those electrons will just start running.  And since there are so many of
them, it gets hot.  We call this a "short circuit".  Generally, short circuits are bad, so usually we want to
slow the electrons down a little.  That's why we need resistors.  

But before talking about  resistors,  lets talk a little more about  batteries.  Basically,  most  batteries are
voltaic cells (named after Alessandro Volta).  The most common one's have 1.5 volts, but there is also the
9 volt kind, that we will be using a lot.  In the examples here, we will use 5 volt batteries.  You can't buy
those, but you can take three 1.5 volt batteries, connect them in series and you get 4.5 volts, close enough.

What did I mean, when I just said "we connect them in series"?  Well, if we have two (or more) batteries,
then we can connect them in several different ways, and the two important one's are to connect them "in
series" and "in parallel":

single battery batteries in series batteries in parallel

When we connect batteries

• in series, the voltage doubles, 
• in parallel, the voltage stays the same. 

Notice, how the plus pole and minus pole of the batteries are connected.  It is not a good idea, to connect
them in any other way.
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Short Circuit
Short circuiting [4] a battery is very dangerous!  It can cause a fire or even an explosion!  That is why we
need to know about short circuits and how to recognize them.  A short circuit is whenever you directly
connect the plus pole and minus pole of a battery.  This can happen directly or indirectly, as depicted in
the following two diagrams:

short circuit of a single battery short circuit of two batteries

Although a 9V battery may seem pretty harmless, if used in the wrong way, it can cause a fire, or in
extreme cases they even might explode.  Just search for "lithium ion explosion" on YouTube, and you will
know what I am talking about.

There are several steps to make sure you do not have a short circuit:

1. double check your setup before connecting the battery, 
2. have somebody else double check your setup (four-eyes principle [5]), 
3. run your setup in a simulator, most simulators check for short circuits, 
4. use an ohm-meter in place of the battery, before connecting the battery.  If the ohm-meter reads

zero ohms, you have a short circuit, and you should not connect the battery. 

Despite taking all these precautionary measures, it might still happen that you have a short circuit.  How
do you know that you have a short circuit?  Any of the following are signs that you have a short circuit:

• if it starts smelling, 
• if it starts smoking, 
• if it gets hot. 

Any one of those is a sign that you have a short circuit!  In case that happens:

Disconnect the battery!

This is also, why you should never leave an electric circuit unattended.  Even for a  short toilet break,
disconnect the battery!  Never leave an electric circuit unattended!

Direction of Current
Historically, people were thinking that the carriers of charge were positively charged.   They did not know
that electrons were negatively charged.  So for them, the current was flowing from the plus pole of the
battery to the minus pole.  Only after  J.  J.  Thomson discovered the electron,  did we know [6].  But
nobody ever  had  the  guts  to  change  that  convention,  and  hence  we  are  still  stuck  with  this  stupid
convention.  Although we know now it is the electrons that are the charge carriers, and it is the electrons
that do the moving, and they really move from the minus pole to the plus pole, the convention still is to
say that the current flows from plus to minus.  Sorry.  Interesting enough it makes no difference.
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Resistor
Resistors restrict the flow of  current.  To much  current, like to much alcohol, is not good. 
That's why we need  resistors.  Resistance is measured in  Ohms.  Right, that is the Georg-
Simon guy our university is named after.

For resistors, there is an interesting relation between current and voltage, which is called Ohm's law [7]:

It says that if you have a voltage of 1 volt [V] and a resistance of 1 Ohm [Ω], then a ], then a current of 1 ampere
[A] is flowing.  If you increase the resistance, the current goes down, if you decrease resistance, current
goes up.  If the resistance is zero, you have a problem: we call this a "short circuit".

Like with batteries, once we have more than one resistor, we can place them in series or in parallel:

single resistor resistors in series resistors in parallel

Resistors have two very important applications:

• Protector, i.e.  resistors limit the current flowing through components, hence protecting them, an
LED for instance. 

• Voltage divider: i.e., resistors can be used to divide a voltage, which is to say, allow us to create
an arbitrary voltage between zero and the voltage of the battery. 

Variable Resistor
Normal resistors are constant, meaning their resistance does not change.  However, there are
also resistors whose resistance changes. The simplest one being the potentiometer, sometimes
also called trimmer.  You can change its resistance by either moving a lever (old style, several
hundred years ago) or turn a knob (new style, only a hundred years old):
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potentiometer

There are also variable  resistors that change their  resistance depending on  temperature, and others that
change their resistance depending on light intensity.  Others change their resistivity when stretched, others
when shouted at, called microphone.

Kirchhoff's Circuit Laws
Some  people  like  to  play  computer  games,  other  people  like  to  do  Sudokus,  others  do  cross-word
puzzles.  Electrical engineers, however, love to calculate what the  voltages and currents are at different
locations in a given electrical circuit.  Since you decided to become an engineer (it was not my decision,
mind you!), you got to change habits (no more computer games), meaning you got to learn about them
Kirchhoff Laws [8].  Lucky for you, there is only two of them.

We start with the second one,  Kirchhoff’s  Voltage Law: all  voltages in a closed circuit add up to zero. 
The tricky part in the second law is the sign of the voltage.  Basically, the direction of the current, gives
the sign of the voltage.  Except for batteries, there it is reverse.  So basically we look for loops, and for
every component we have, we write down a voltage.  In the example below, that is for the battery, v0, for
the first  resistor, v1, and for the second  resistor, v2.  Since those three components form a loop, these
voltages have to add up to zero.  And since v0 is a battery, it gets a minus sign.  Easy.

The other Kirchhoff law, the first one, is also called the Current Law: all the currents coming in and out of
a node add up to zero.  A node is where a bunch of wires come together.  And usually currents going into
a node get a plus sign, and  currents going out, get a minus sign.  In the diagram below there are two
nodes. We just worry about the upper one (in this case the lower one gives the same result).   As you can
see, there is i0 coming into the node, and i1 and i2 are coming out of the node.   Hence, i0 gets a plus sign,
and i1 and i2 each get a minus sign.  These three currents all must add up to zero.
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In addition, you see that in this example, there are also two loops.  So from Kirchhoff's second law we get
two more equations.  And turns out, if you are good at math-gymnastics, that is enough to calculate all the
voltages and currents in this circuit. 

Conservation Laws
Now once in a while it is good idea to stop for a moment, and appreciate the philosophical deepness of
certain statements.  We will do this a couple of times in these lectures, this one being the first time.  We
call this enlightenment, and at least in my opinion, we still live in the age of enlightenment [9], one of the
few great contributions of Europe to the World (although most of the world does not know about it).

Kirchhoffs  first  law,  is  nothing  but  the  conservation  of  charge.  Kirchhoff’s  second  law,  is  simply
conservation  of  energy  put  in  another  form.  So  both  of  them  are  conservation  laws.  Where  do
conservation laws come from?  Well, since we mentioned Georg-Simon Ohms name, let us also mention
another persons name, of local origin: Emmy Noether [10].  Emmy Noether proved that:

"If a system has a continuous symmetry property, then there are corresponding quantities whose
values are conserved in time."

American physicists Leon M. Lederman and Christopher T. Hill argue in their book Symmetry and the
Beautiful  Universe [11] that  Noether's  theorem is "certainly one of the most  important  mathematical
theorems  ever  proved  in  guiding  the  development  of  modern  physics,  possibly  on  a  par  with  the
Pythagorean theorem".  Albert  Einstein described her as the most  important  woman in the history of
mathematics [12].

Just to emphazise this a little more: there is not a single physical theory that is not a consequence of
Noether's theorem.  All of modern physics, that is QED, QCD, electroweak theory and Einstein's theory
of gravity are all a consequence of Emmy Noether's theorem!  If that does not impress you, nothing will.

Measurement
So how do we know that the Kirchhoff laws actually are correct?  Well, we check, meaning we measure. 
For measuring DC we usually use a multi-meter device, that can measure voltage, current and resistance. 
For now we do not need to understand the internal workings of a multi-meter, but we need to be aware
that depending on what we want to measure, we have to use the multi-meter in slightly different ways:
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• Resistance: when measuring  resistance, the component is  not connected to the  battery, and we
simply connect it to the multi-meter. 

• Voltage: we measure voltage accross a component, while it is connected to the battery. 
• Current: we measure current that goes through a component by inserting the multi-meter in front

or after the component, also while it is connected to the battery. 

And the multi-meter has to be set to the respective settings, sometimes you also have to use different
terminals, depending on the IQ of your multi-meter.  Most multi-meters are stupid, so you have to be
smart.  Below are the diagrams depicting the different ways these measurements are done:

measuring resistance measuring voltage measuring current

When measuring  current, you have to be careful not to break the multi-meter.  Please use the four-eye
principle before trying to measure  current.  On average, about half of the multi-meters in our labs get
"fried", because students have not been careful when trying to measure current!

Voltmeter
We learned how to measure charge (electroscope) and how to measure current (ammeter = coil
+ needle).  But how do we measure voltage?  From what we just learned, the way we measure
voltage is  by  connecting  the  voltmeter  parallel  to  the  component  we  want  to  measure.   Now if  we
remember Ohm's law,

we can calculate the voltage, if we know the resistance R and the current I.  So we build our voltmeter out
of our ammeter and a known  resistor (1 kOhm, for instance).  Then instead of measuring  voltage, we
measure current, and multiply by the resistance (times 1000, for 1 kOhm) to get the voltage.  Pretty smart,
or?
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voltmeter

Capacitor
There are two more components we need to talk about and that is capacitors and inductors. A
capacitor is basically two metal plates separated by air or some insulator.  The Leyden jar is a
capacitor and our burrito is a  capacitor.  By themselves  capacitors are pretty useless, except for energy
storage.  But together with other components, and especially when dealing with AC, they become really
useful.

Like resistors, capacitors can be placed in series and in parallel:

single capacitor capacitors in series capacitors in parallel

Capacitors have three very important applications:

• Energy store: a capacitor stores "energy" like a battery (in the electric field). 
• Gate: a capacitor will not let DC pass, but it will let AC pass. 
• Timer: since it takes some time for a capacitor to charge (or discharge), they are very often used

for "timing". 

Inductor
When an electric current runs through a wire, it creates a magnetic field.  Turns out that when
you wind the wire up in a coil, the magnetic field gets stronger,  the more turns the stronger
the field.  Such a coil is called an inductor and has a couple of useful properties.  We need to learn about
inductors, because  motors, relais and  servos are  inductors.  As such they have the property to  induce
current into our circuits (hence the name).  This inducing of current sounds pretty innocent, but not to our
Arduinos: they tend to get killed by those induced currents.  So to protect our Arduinos, we need to learn
about inductors.

Inductors have four important applications:

• Energy store: an inductor can store energy (in the magnetic field). 
• Magnet:  an  inductor always  has  a  magnetic  field,  which  can  be used to  lift  or  move things

(electromagnet, motor, servo, relais). 
• multi-meter: basically all analog multi-meters use a coil to move their needle. 
• Transformer: out of two inductors you can make a transformer, but only with AC. 

And last but not least, almost all loudspeakers use coils.
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Kirchhoff and Ohm Revisited
Kirchhoff's laws are conservation laws, and therefore they are always valid.  Ohm's law on the other hand
is  only  true  for  resistors.  So  if  we  are  dealing  with  capacitors,  inductors  or  any  other  electronic
components other than resistors, then Kirchhoff's laws still hold true, but Ohm's law is not valid.  To see
this, let us consider the following circuit in detail:

Kirchhoff's laws

Switch and Logic Gates
Let's return to the switch for a moment: it seems to be the most trivial of all components.  Which is kind
of true.  Still it has some nice surprises for us.  We start simple, and take a look at the following two
circuits:

switch and lamp NOT gate

The first is really trivial: you turn on the switch, the light goes on, you turn the switch off, the light goes
off.  But, in the second circuit it is the reverse.  That's kind of cool.  What we have is  a logic NOT gate: if
the switch is on, the light is off, and vice versa.  We can write this down in what mathematicians call a
truth table:

Switch Light

off on

on off
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It turns out that using switches, we can build all the  logic gates mathematicians know about.  Here are
examples for the AND, the OR and the XOR gates:

AND gate OR gate XOR gate

And finally, there is one very special logic gate, the NAND gate:

NAND gate

There will be another philosophical comment on the NAND gate, but that will have to wait a little.

Review
This chapter introduced us to electric circuits and electronic components such as batteries,  resistors, all
kinds of variable resistors,  capacitors and inductors.  We briefly heard about AC and DC, as well as the
direction of current.  We talked about short circuits and their potential dangers.  We saw how to measure
resistance,  voltage and  current, and got to know Ohm's and  Kirchhoff's laws.  We now know what the
difference is between putting things in series or in parallel.  At the end we even met the  logic gates.  I
would call this an intellectual tour de force.
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Labs
In  this  lab  we  will  learn  about  simple  circuits  and  passive  electronic  components  such  as  resistors,
variable resistors,  capacitors, and inductors.  We will also use Ohm's law, and verify Kirchhoff’s circuit
laws.

Preparations
Before attempting to perform any of the experiments in this lab, you need to have done the following
preparations beforehand:

• you must have read the article on short circuits [4], 
• you must be able to identify plus and minus pole of a battery, 
• you must know how to measure voltage vs current, 
• you must know the color codes of resistors, 
• you must know the difference between putting components in series and in parallel. 

You should also draw all the needed circuit diagrams for the different experiments below, before you
come to lab.  If something is unclear, please ask one of the instructors before attempting the experiment!

Note to Instructors
Equipment needed for  the  labs  in  this chapter:  Arduino box,  alligator clips,  multi-meter,  9V  battery,
inductors.  Mark the Arduino boxes with the students names, so that every group gets the same box again.

0. Circuit Simulator
Before you start with the experiments, make sure you make yourself familiar with the circuit simulator,
appendix C.  You should make sure that you try out the simulations of each experiment first.   Because, if
the simulation does not work, the real experiment will definitely not work! 

1. Resistor
Equipment: Arduino box, multi-meter.

Familiarize yourself with the color code of resistors [13].  Important is the third ring, and the important
colors are black (=0), brown (=1), red (=2), orange (=3), yellow (=4).   Also notice red-red-red is 2.2
kOhm, also denoted as 2K2. 

Take a couple of different  resistors from the Arduino box, try to predict their  resistance using the color
code.  Then use the multi-meter to verify your prediction.

Question: what would you guess is the next color after yellow?

2. Resistors in Series and in Parallel
Equipment: Arduino box, multi-meter.

When you put resistors in series, their values simply add up:

If you put them in parallel, their inverses add up:
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Verify this by putting two 10 kOhm resistors first in series and then in parallel.  Use the multi-meter to
measure the total resistance in each case.

3. Protector
Equipment: Arduino box, multi-meter, 9V battery, LED.

One of the most important applications of the resistor is that of the protector.  Let's consider an LED.  The
current going through an LED should be around 20 mA.  If the current is much higher, the LED will die. 

If you recall Ohm's law:

We can find the required resistance for a given voltage and current:

We have a 9V battery, and the current flowing should be 20 mA.  With this you can calculate the required
resistance to protect the LED.  Most of the time, you will not find exactly the right resistor.  In that case,
you pick the closest one, that is a little higher than the calculated one. 

Build the circuit consisting of the battery and the resistor.  Do not add the LED yet.  Now measure that
the  current through that circuit is less than 20 mA.  Once you verified that, add the LED.  (Make sure
LED and resistor are in series!  And, LEDs only work in one direction, its cathode should be connected to
minus.)

4. Voltage Divider
NOTE: use resistors with high resistance, like the 1kOhm, 4.7kOhm and 10kOhm!

Equipment: Arduino box, multi-meter, 9V battery.

Another important applications of resistors is that of the voltage divider.  Assume, you need a voltage of
something like 3 volts.  How do you do that?  You put two resistors in series and use Kirchhoff's law to
calculate the value of the voltage in the middle.  Draw a circuit with a 9 volt battery and the two resistors,
and write down all the voltages.   Then build the circuit, and verify your calculation.  Maybe use the 4.7
kOhm and the 10 kOhm for a first try.

5. Kirchhoff's Circuit Laws
Equipment: Arduino box, multi-meter, 9V battery.

Important: Before attempting to do this experiment, make sure you understand how
to measure current!  If you are not certain, please ask your instructor.

In  class  we  learned  about  Kirchhoff's  circuit  laws.  We  want  to  verify  them  be
building the two circuits to the right.  Use two resistors of more than 1kOhm for R1

and R2,  but make sure they are different.  Then first  calculate all  the  voltages and
currents in these circuits.  Finally, verify this, by measuring the voltages and currents
with the multi-meter.
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6. Potentiometer
Equipment: Arduino box, multi-meter, 9V battery.

The simplest variable  resistor is the  potentiometer.  Basically, our simple graphite pencil  lead  resistor
already was a variable resistor.  They are very practical.  A very common application is to use them as a
continuous voltage divider.  Build the circuit example from class, using a 9V battery, and show that you
can create any voltage between 0 and 9 volts this way.

First,  use multi-meter in ohm setting, to see which pins of the  potentiometer you need to connect to
where.

7. Variable Resistors
Equipment: Arduino box, multi-meter.

There are also other variable  resistors.  In our Arduino box, there are two: one for light and one for
temperature.

The  light  depending  resistor (LDR)  (also  called  photoresistor or  phototransistors  [14])  changes  its
resistance depending  on  the  amount  of  light  entering  it.  The  one  in  our  Arduino  box  looks  like  a
transparent LED.  Simply connect the two leads to our multi-meter and measure  resistance.  You will
notice that the resistance changes depending on the light entering the LDR.  Also notice, that it makes a
difference which way you connect the LDR.  For now, we don't have to worry about this.

Our Arduino box also contains a temperature sensor, the TMP36 to be exact [15].  The TMP36 looks like
a transistor.  We connect the two outer terminals to our multi-meter and we measure resistance.  You can
warm up the TMP36 by holding it in your hands.  You will notice how the resistance changes, depending
on temperature.  Again, it seems to make a difference which way you connect the TMP36.

8. Capacitor
Equipment: Arduino box, multi-meter, 9V battery, blue LED.

First, take one of the electrolytic  capacitor from the Arduino box and measure its  capacitance with the
multi-meter.

Second, connect the big electrolytic capacitor (100 uF) with the 9V battery.  Be careful about the polarity,
i.e. connect the minus of the capacitor to the minus of the battery.  Then connect the capacitor to one of
the blue LEDs.  If you connect it correctly, the LED should light up briefly. (Don't do this to often, or with
a very strong capacitor, it might destroy your LED.)

Third, we want to put capacitors in series and in parallel.  Theoretically, when two capacitors are put in
series, their inverses add up:

However, if they are put in parallel, their values simply add up:

This is very different from the way resistors behave.  Verify this by putting two capacitors first in series
and then in parallel.  Use the multi-meter to measure the total capacitance in each case [16,17].

Fourth, we want to measure the voltage over time.  To do this, you measure the voltage a) while charging
the capacitor and b) while discharging the capacitor.  Make a measurement like once a second, write your
observations down in a table, and then use the table to draw a graph using the graph paper provided.
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9. Generator
Almost all electric motors can also be used as electric generators.  Connect the motor to the multi-meter,
which should be set to measure volts.  Depending on how fast you turn the motor, you may want to select
the AC setting.  However, if you turn your motor slowly, the DC setting should work fine.  Turn the motor
and notice that there is a voltage. 

Because electric  motors also are  generators, they are potentially dangerous for our Arduino, because if
they generate more then 3.3 volts, and very often they do, it will kill our Arduino, unless we know how to
protect it (next chapter).

10. Inductor
Equipment: Arduino box, multi-meter, inductor.  Could also use motor for this!

For this experiment, you should use one of the inductors or the coil might also work.

First, take one of the inductors provided and measure its inductance with the multi-meter.

Second,  we should also be able to use  inductors to store some energy.  For this,  build the following
circuit:

inductor

As long as you keep the switch closed, the current flows through the inductor, creating a magnetic field. 
The moment you release the switch, no more current is coming out of the battery.  But now, the magnetic
field creates a current, and that is why the LED should light up briefly.

Third, inductors too can be put in series and in parallel.  Find out how the formulas go for inductors in
series and in parallel, and verify them [18].

Challenges

1. Challenge - Logic Gates
Equipment: Arduino box, multi-meter.

With the switches from the Arduino box, build some of the logic circuits we talked about in class:

• NOT 
• AND 
• OR 
• XOR 
• NAND 
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2. Solar Cells
Equipment: multi-meter, small solar cell.

Measure the voltage and amperage of a small solar cell.  Change the light, sun
light  would  be  ideal.  Make  different  measurements  with  different  light
settings.  Calculate the power production.  How much power does a 100 watt
incandescent light bulb use?  A hair dryer?  An electric car?  For more details see reference [19].

Remember that power (P), which is measured in Watt [W], is simply voltage times current, i.e.,

On a  clear  day,  the  sun's  energy reaching  the  Earth's  surface is  about  1000  Watts per  square  meter
(W/m^2).  How efficient is your solar cell?

Questions
1. Is a resistance of 100 ohms a high resistance, or rather a small one?

  
2. What is the color code of a 2.2 kOhm resistor?

  
3. You can connect batteries in series or parallel. How high is the total voltage in one or the other 

case?
  

4. We have worked with different variable resistors. Name three different types of variable resistors.
  

5. What can go wrong when you try to measure current?
  

6. How to measure current, how to measure voltage, and how to measure resistance? Sketch one 
circuit diagram each.
  

7. Name the two Kirchhoff laws.
  

8. Consider the following voltage divider. The battery supplies 9 volts, one resistor is 300 Ohm, the 
other 600 Ohm. What is the voltage in the middle, between the two resistors? Which law do you 
use to calculate this? 

9. Why should you use resistors with high resistances in a voltage divider?
  

38

http://falstad.com/circuit/circuitjs.html?whiteBackground=true&startCircuitLink=http://127.0.0.1:9080/JSPVorlesungen/UserFiles/Image/pc/astable_multivibrator.txt


Electronic Components

10.Consider the following circuit. It consists of a 7.5 volt battery, a resistor R1 of 100 Ohm and a 
resistor R2 of 300 Ohm. Calculate the currents I1 and I2 that flow through the resistors R1 and R2. 

11.Name two important applications of capacitors.
  

12.First connect an electrolytic capacitor to a 9V battery. Then connect the capacitor to an LED. 
What happens?
  

13.Most LEDs die when the current through them is more than 20mA (for humans it is a little more, 
but not much). You only have a 9V battery, but you also have a lot of resistors. What do you do to
get some light without killing the LED? 
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Active Components

  

This chapter is about active electronic components, such as diodes, LEDs, and transistors.  We learn about
the different type of diodes that there are and what they are used for.  We get to know transistors, bipolar
and  field-effect, and how to use them as  switches and as  amplifiers.  We get to see the  multivibrators,
especially the astable and the bistable, and learn why they are so important for computers.
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Diode
The diode [1] is the most basic active component. It is made out of a semiconductor material
with what is called a p-n junction [2].  Diodes have the nice property, that they let current only
go one way, from anode to cathode.  Let's take a look at this in our simulator:

diode forward diode blocking

You may notice this interesting  voltage drop of 0.7 volts across the  diode.  This is also known as the
"forward bias" [1].  This is typical for a silicon semiconductor, and we will see this a few more times in
the future.  Germanium diodes have a voltage drop of about 0.3 volts.

Diodes have many uses, such as

• constant voltage source, 
• current steering, 
• over-voltage protection, 
• temperature sensor and 
• rectifier. 

We will not talk about the rectifier, since that has to do with AC, but we will see examples for all the other
usages.

Constant Voltage Source
We just learned that a silicon diode has a voltage drop of 0.7 volts.  This can actually be used to create a
constant  voltage source.  If we connect three  diodes in series, the  voltage drop will be three times 0.7
volts, that is 2.1 volts.  Depending on whether we have the diodes before or after the resistor, we can use
them in two different ways:

diodes before a resistor diodes after a resistor

52

http://falstad.com/circuit/circuitjs.html?whiteBackground=true&startCircuitLink=http://127.0.0.1:9080/JSPVorlesungen/UserFiles/Image/pc/diode_forward.txt
http://falstad.com/circuit/circuitjs.html?whiteBackground=true&startCircuitLink=http://127.0.0.1:9080/JSPVorlesungen/UserFiles/Image/pc/diode_blocking.txt
http://falstad.com/circuit/circuitjs.html?whiteBackground=true&startCircuitLink=http://127.0.0.1:9080/JSPVorlesungen/UserFiles/Image/pc/diode_constant_voltage_high.txt
http://falstad.com/circuit/circuitjs.html?whiteBackground=true&startCircuitLink=http://127.0.0.1:9080/JSPVorlesungen/UserFiles/Image/pc/diode_constant_voltage_low.txt


Active Components

Current Steering
Diodes are also very useful in protecting sensitive electic circuits from somebody accidentally switching
plus and minus, i.e. they can be used to allow current to flow only in one, the intended, direction:

diode protection series diode protection parallel with fuse

Just so that you know, this last circuit, protects our multi-meters when you happen to measure current in
the wrong way.  Meaning the way that "breaks" the multi-meter.  Lucky for you, most multi-meters are
protected by this circuit, and all you have to do is to replace the fuse, and your are good to go. 

Over-Voltage Protection
They also can be used for over-voltage protection, especially when dealing with  motors or relays (fly-
back diode):

diode protecting motor

Temperature Measurement
The voltage drop of 0.7 volts that we already heard about, actually depends a little on  temperature for
most diodes.  For silicon diodes it is usually -2 mV/˚C.  So if we very carefully measure this voltage drop,
we can measure the temperature. 
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Current-Voltage Characteristic
At this stage it is time to learn about what is called the  current-voltage diagram, also called the "I-V
characteristic".  Basically,  we  change  the  value  of  the  voltage going  through  our  diode from  some
negative voltage to some positive voltage, and measure the current.  (Naturally, the current should not be
to high, or our  diode will start to go up in smoke.)  When plotting the result in a graph, we will get
something like the diagram below.

Usually, we will not measure these diagrams ourselves, but look them up in so-called data-sheets [4].  The
manufacturers of the components usually provide them.

Light Emitting Diode (LED)
LEDs are diodes that emit light [5], however, only if connected in the right direction, because
like diodes, they let current only pass in one direction.

led with current-limiting resistor

Most  LEDs need to be protected, if the  current through them gets to high, they break.  This is why we
usually use a current-limiting resistor to protect them.
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Zener Diode
We already saw how to use a normal diode to create a source of constant voltage.  Only, that
voltage wasn't quite as constant as we would have wanted it to be.  That is why there is a
special diode called the Zener diode [6]: its only purpose is to create a constant voltage.  It is based on the
Zener effect.  Normal diodes will block any current, that goes in the wrong direction, i.e. from cathode to
anode.  But a Zener diode will block it only to a certain voltage, if the voltage increases above that value,
it will no longer block.  The diagram below shows the current-voltage diagram for three different Zener
diodes.

For  us,  Zener diodes  are  important,  because our  Arduino,  the  MKR1000,  only likes  3.3 volts  as  its
voltage.  Most USB power supplies, however, produce 5 volts.  So with a Zener diode, we can turn 5 volts
into 3.3 volts.  There are Zener diodes available for all kinds of voltages [7].

Zener diode

Transistors
Although diodes are already pretty neat,  transistors are what we really want to learn about.  Transistors
can act as  switches and as  amplifiers.  The simple diagram below, visualizes how they work: a small
current of water, the pipe coming in from the left, controls the flow of the water in the big pipe.   If there is
no flow coming in from the left, the main water pipe is blocked.  Only if water flows in from the left, will
the gate open, and release the main stream.  This is a very crude analogy, but a very helpful one.
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Bipolar Transistor
The  bipolar transistor was invented in 1947 by American physicists  John  Bardeen, Walter
Brattain, and William Shockley at Bell Labs [9].  It has transformed our lives like no other
electronic device, and probably is on par with the invention of the fire and the wheel.  It is
surprisingly simple, made up of two semiconductor junctions (npn or pnp).

A transistor has three terminals, called base (B), collector (C) and emitter (E).  The defining
feature of a transistor is that a small current flowing into the base terminal, can control a much
larger current flowing from the collector to the emitter terminal.  Hence it can be used either as a switch
or as an amplifier.

Transistor as Switch
If you want to use the transistor as a switch, all you have to do put a small voltage on the base terminal,
usually a little more than 0.7 volts for a silicon transistor:

transistor switch off transistor switch on

If the base voltage is less than these 0.7 volts, the transistor is off, meaning no current is flowing between
collector and emitter.  However, if the base voltage is higher than about 0.7 volts, than the transistor is on,
meaning a high current is flowing between collector and emitter.
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Transistor as Current Amplifier
In addition, a transistor can be used as an amplifier, which is its most important application.  There are
three configuration to do that, and they are called

• common base, 
• common emitter, and 
• common collector. 

Since the first one is hardly used, we will not talk about it.  The second one is the most common one, and
the last one is also used quite often.  

common emitter common collector

You can remember which is which, by looking at the emitter of the transistor: if the emitter is connected
to (common) ground, then it is common emitter.  Although the diagrams look almost the same, the two
amplifiers have somewhat different properties.  We put those differences together in one table [10]:

common emitter common collector

input impedance medium high

output impedance high low

voltage gain medium low

current gain medium high

power gain very high medium

phase shift 180º 0º

typical use switch, amplifier impedance matching

So depending on what you need, you pick one or the other.  If you are not sure, go for the common
emitter.

Transistor as Voltage Amplifier
First and foremost,  bipolar transistors amplify current.  But what if we want to amplify voltage?  Well,
with a resistor and Ohm's law we can turn voltages into currents:

turn voltage into current
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But, in addition we need to remember, that the voltage drop between base and emitter has to be around
0.7 volts.  We can do this by adding something like 0.5 volts to our input signal with a voltage divider
(that is two resistors).

Once we have that, we can amplify voltages.  In the example below, we amplify an input voltage with a
range of 0 to 0.9 volts to an output voltage of 0 to 9 volts, that is an amplification by a factor of 10.

voltage amplifier

You may notice the phase shift of the common emitter circuit: the 0V input  voltage is turned into a 9V
output voltage and the 0.9V input voltage is turned into the 0V output voltage.

Field-Effect Transistor (FET)
Besides  the  bipolar transistors,  there  are  also  the  field-effect  transistors  (FET)  [11].  In
principle, they are quite similar.  The main differences are, that one, the terminals of FETs are
called source, drain, and gate (corresponding to emitter, collector, and base, respectively), and
two, they are triggered by voltage and not by current.  Meaning no current has to flow through
the gate for the transistor to switch.  It basically turns voltage into current:

FET transistor

This has an interesting consequence that you should be aware of:  the bipolar transistor will only be "on",
when a current is flowing.  Not so the FET.  To see this, consider the following circuit:
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FET as switch

If you replace the FET in the circuit above with a bipolar transistor, you will notice the difference.  To see
the effect in practice, watch video [12] starting at position 5:00 minutes.   Also notice the different voltage
it needs to be turned on and off.

Why are FETs, especially MOSFETs, so important?  Because they can be fabricated much smaller then
bipolar transistors, and therefore basically all integrated circuits are made with FETs.

Multivibrators
Three  very  interesting  circuits  that  we  can  build  out  of  transistors,  resistors  and  capacitors are  the
multivibrators [13].  They  are  interesting  because  we  need  them  to  build  a  computer.  The  astable
multivibrator generates the clock cycles for our computer, and the bistable multivibrator is the basic unit
that stores the bits in the memory of our computer, i.e. the RAM.

Monostable Multivibrator
We start with the simplest,  but also most useless of the  multivibrators, the monostable  multivibrator. 
When you close the switch in the circuit below, the dark LED will lighten up, but after a while, the other
LED will turn on again, and stay on.  So one of the two LEDs (two states) is the stable state, hence mono-
stable.  It is not totally useless, and its usually used to turn a rather short signal, into a longer signal of a
fixed time interval.

monostable multivibrator
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Astable Multivibrator
Next up is the astable multivibrator. Again, it has two states (or LEDs), but the interesting thing is, that it
keeps on switching back and forth between the two states, i.e., none of the states is stable, that is astable. 
This is a frequency generator.  It can be used to generate the clock-cycles for our computer.  Depending
on the values for the resistors and capacitors, basically any frequency can be generated.  We can also use
it to create a blinker or we can use it to create sound, if the frequency is high enough.

astable multivibrator

Bistable Multivibrator
Finally we come to the bistable multivibrator, also called flip-flop.  Again, it has two states (LED on or
off).  But this time, both of the states are stable. When we close the "reset" switch, the LED is off.  When
we close the "set" switch, the LED turns on.  And stays on, until the "reset" is closed again.  And this is
the type of circuit that your computer uses to store information, one bit to be exact.

bistable multivibrator
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Logic Gates
The other important application of  transistors are the  logic gates [14].  In the second chapter, we have
seen how to build them out of switches.  Since transistors can act as switches, it is not surprising that we
can build them also out of transistors.  Below you see all the logic gates build with transistors, we start
with NOT, AND and OR,

NOT gate
AND gate OR gate

continue with NAND and the NOR,

NAND gate NOT-XOR gate

and notice, that we can turn the NOT-XOR into an XOR by inverting its output with a NOT gate:

XOR gate

In the research section, we will talk a little more about the  NAND gate and its profound philosophical
implications.
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Review
In the lines above, we focused on active components, such as diodes and transistors.  To be more exact,
we saw silicon diodes, LEDs and Zener diodes, as well as bipolar and field-effect transistors.  We learned
that diodes can be used as constant voltage source, for current steering and over-voltage protection, even
temperature measurement.  We now know how to use transistors as switches and as amplifiers, with the
common emitter and common collector circuits.  Finally we learned about the multivibrators, and towards
the end build all the logic gates out of transistors.  Again, pretty amazing what we accomplished.

Labs
In today's lab we will learn about active electronic components such as diodes, LEDs and transistors.

Preparations
Before attempting to perform any of the experiments in this lab, you need to have done the following
preparations beforehand.  You have to be able to

• measure current with a multi-meter, 
• find the direction of a diode and an LED, 
• identify B, E, and C on a bipolar transistor. 

Note to Instructors
Equipment: Alligator clips, Arduino box, multi-meter, engineering paper,  Zener diode 1N5226,  bipolar
transistor BC547.  Experiment 2 should be done in groups of four students since two multi-meter are
needed.

1. Diode
Equipment: Arduino box, multi-meter.

First, take a diode and measure its resistance.  Notice, that a diode has an anode and a cathode.  Identify
each, and measure the resistance in both directions.

Second,  diodes can be used to create a source of constant  voltage.  Use two diodes and a resistor (!) to
create a voltage source of 1.4 volts.

diode constant voltage source

Third, use a diode for current steering: build the circuit "diode protection series" from class.  Instead of
the light bulb use a motor.  You should notice, that no current is flowing when you switch the poles of the
battery.
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2. Current-Voltage Characteristic of a Diode
NOTE: this experiment should be done in groups of four students.

Equipment: Arduino box, multi-meter, engineering paper.

Important: If  you destroyed a  multi-meter  in  the  last  lab,  because  you did  not  understand how to
measure current, you should not attempt this experiment.

First take a look at the data sheet for the 1N4007 diode [16].  Notice that on the 3rd page it shows several
diagrams  for  the  current-voltage characteristic  of  that  diode.  We  want  to  repeat  one  of  those
measurements. 

Before starting make sure you read reference [17].  You need to be able to create  voltages between +9
volts and -9 volts.  In experiment 6 in lab 2, we created a continuous  voltage source that can give us
voltages between 0 and 9 volts. 

Before attempting to do this experiment with a diode, we can do it with a simple resistor.  Use maybe a 10
kOhm resistor.  Change the voltage from +9 to -9 volts, in one volt increments, and measure the current
flowing.  Write down your measurements in a table, and then graph the table.  You should get a straight
line.

Next,  use the  diode instead of  the  resistor.  Again modify the  voltage,  but  this  time,  in the forward
direction we need voltages between 0 and 1.0 volts, ideally in 0.1 volt increments, and in the blocking
direction we need voltages between 0 and 9 volts, ideally in 1 volt increments.  Again, write down your
measurements in a table, and then graph it.  You should get a graph like the one we saw in class.

current voltage characteristic diode

3. Light Emitting Diode (LED)
Equipment: Arduino box, multi-meter.

An LED is a diode that emits light.  Most LEDs (at least the ones we are using) need protection through a
resistor.  In experiment 3 of Lab 2 we calculated how much resistance is needed for a given voltage.  In
general, the current flowing through a LED should be less than 20 mA.   

First, connect a red LED to the 9V battery in series with its protective resistor.  The LED should light up. 
It will do this, only if connected in the correct way (cathode should be connected to minus).   Next, use the
multi-meter to measure the  voltage drop across the LED (should be something like 1.9 volts).  Finally,
replace the LED with a different color LED.  Notice that the  voltage drop depends on the color of the
LED. 

Second, LEDs can also act as light detectors.  Measure the resistance of an LED in the forward direction. 
Now shine on it with a bright light (smartphone flashlight).  You will notice, that the resistance increases,
depending on the brightness of the light.

As an interesting side note, it is possible to measure Planck's constant measuring voltages and currents of
differently colored LEDs [21].
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4. Zener Diode
Equipment: Arduino box, multi-meter, Zener diode 1N5226.

The Arduino we are using, uses 3.3V for its power.  Most power supplies for Arduinos (like USB power
supplies), and also many of the other Arduinos use 5V.  As long as we stay in one world things are fine. 
But once we start connecting other Arduinos or sources to our Arduino, things might get problematic or
rather deadly for our Arduino.  Also, sometimes you find circuit diagrams on the internet that you might
want to use with your Arduino.  But before you do that, make sure you understand for which Arduino this
circuit diagram was intended. 

However, not all is lost.  Because we can use a  Zener diode to protect our Arduino.  For example, the
1N5226 is a common 3.3V Zener diode which we can use to protect our Arduino. Check out reference
[22] and read the "Level Shifting With a Zener Diode" paragraph.  Then build the following circuit, and
test if it works.

Zener diode voltage characteristic

What you want to measure is the voltage accross the  Zener diode.  You should change the value of the
resistor (maybe 220 Ohm, 1kOhm, 10kOhm) and measure the voltage for each.  You should notice that
the voltage stays close to the 3.3 volts.  Our Arduino input is protected!

5. Bipolar Transistor
Equipment: Arduino box, multi-meter, transistor BC546, 1.5V and 9V batteries.

First, you need to find the transistor's data sheet [23].  Use it to identify base, emitter and collector of your
transistor.

Second, make sure to always protect the base with a protective resistor.  If you don't, your transistor goes
ka-boom.

Third, find out how to use the multi-meter to test if a transistor is NPN or PNP.  In addition, you can test
this way if your transistor is fine or already broken.  Note the hFE your multi-meter displays. Find what
the hFE should be for your transistor in the data sheet.

Fourth, to get started, connect the  motor directly to the 1.5 volt  battery.  Notice, that it moves rather
slowly. Then connect it directly to the 9 volt battery.  It is going quite a bit faster.

Finally, build the circuit below.  Notice, that the motor turns pretty fast.  Change the resistor to 100 Ohms
(put two 220 Ohms in parallel).  The motor now should turn as fast as if it were directly connected to the
9 volt battery.  DO NOT MAKE THE RESISTOR SMALLER THAN 100 OHM!
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transistor as switch motor

If you are good at using the ammeter (i.e. you haven't broken one yet), you can measure the current going
through the motor (use the 10A setting).  You can compare that to the current going into the base of the
transistor (use the 200mA setting). I measured a current of 140mA going through the motor and of 1.3mA
going into the base of the transistor.  Hence the amplification is about:

Looking at the hFE we measured (or looked up) we would expect a little more, but close enough.

Question: What is the hFE of the Darlington transistor TIP120 [24]?

6. FET as Switch
Equipment: Arduino box, multi-meter, FET IRF520

FETs are more robust than bipolar transistors, since they do not react to current but voltage instead. This
means we can directly connect the gate to 9 volts of the battery without destroying it (a bipolar transistor
would not survive this). 

First, check out the datasheet [25,26] and use it to identify the gate, drain and source terminals of your
FET.  Then find out what the "Gate-Source Threshold Voltage" is.  You need to apply at least this voltage
for the FET to switch. 

Second, find out if you can use the multi-meter to test a FET transistor.  It probably will not work.  Is
there another way?

Third, build the "fet switch" example below. Notice, what happens when you connect the gate to 9 volt,
and what happens when you connect it to 0 volt, i.e. the minus pole of the battery.

FET as switch motor
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Finally, try the following: using the circuit above, make sure the motor is turned off.  Now rub your feet
on the floor, and then touch the gate terminal of your FET.  With some luck, the motor will turn, because
the  static electricity generated by your feet is high enough to turn on the FET.  (Nowadays,  FETs are
usually protected against static electricity.  If they weren't you would have just killed it...).

Question:  What  are  the  advantages  of  a  bipolar transistor,  and  what  are  the  advantages  of  a  FET
transistor?

7. Multivibrators
Equipment: Arduino box, multi-meter, transistor BC546.

First, recall how capacitors work.  When you charge them, and then discharge them, the voltage decreases
slowly, following an exponential decay.  Then build the circuit below.  You will notice that when you
close the switch, the LED goes on (use a yellow LED for best results).  As you release the switch, you
will notice that after some time, the LED gets dimmer slowly, until it goes off.   Depending on the 220
Ohm  resistor and the  capacitance, this will  take a different amount of time.  This is the basis for the
multivibrators.

 multivibrator

Now we are ready for the real thing.  Make sure you understand the difference between the different
multivibrators.  Although they sound and look almost the same, they have very different applications. 
Then  build  the  astable  and  the  bistable  multivibrator.  You  can  use  the  FETs instead  of  the  bipolar
transistor, they work as well.  As for the astable, notice what happens when you change the values of the
capacitors or the charging resistors (10kOhm). (Don’t change the protective resistor or your LED will say
bye-bye!)

Challenges

1. Current-Voltage Characteristic LEDs
Like with diodes, you can also measure the current-voltage characteristics for LEDs.  Interesting enough,
you will notice a dependence on the color of the LED.  And even more interesting, you can use this to
measure Planck's constant [21].  Explaining this effect is what got Albert Einstein his Nobel Price.

2. Current-Voltage Characteristic Transistors
Like diodes, transistors too have current-voltage characteristics.  We will take a brief look at those in the
references [27,23,26].  But you can actually measure them yourself.
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Research

Sheffer Stroke
A few pages ago we mentioned that the NAND gate is very special [29].  Mathematicians actually call it
the Sheffer stroke [28].  Why is it so special?  It turns out that all other logic circuits, that is the NOT, the
AND, the OR, even the XOR and the NOR can be build out of  NANDs.  This is totally unexpected. 
Interesting enough, the Sheffer stroke is what Mathematicians call funcionally complete [30].  Knowing
this and having heard about the Principia Mathematica [31], one may marvel at the simplicity of the
creation.

Questions
1. How can you determine whether a diode is a silicon or germanium diode? What do you have to 

measure?
  

2. Can an LED be used as a detector for light? 
• yes 
• no.

  
3. Suppose you are color blind. How could you find out the color of an LED by measuring 

something?
  

4. Sketch a current-voltage characteristic curve for a diode.
  

5. Does a bipolar transistor amplify current or voltage by default?
  

6. Which one breaks more easily, a bipolar transistor or a FET?
  

7. Please draw the diagram of a bipolar transistor and label base (B), collector (C) and emitter (E).
  

8. Transistors are typically used in the common emitter or common collector configuration. Draw 
the schematic for one of the two.
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9. Identify which multivibrator is which.
 

  
10.Connect the component on the left side with its function on the right side:

       TMP36                                  diode

BC546  CPU

IRF520  FET transistor

   1N4004   bipolar transistor

741  operational amplifier

6502  temperature sensor
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Arduino

We have arrived at the final chapter, we are ready to do some physical computing [1].   We will use an
Arduino board and connect it with the different electronic components we learned about in the previous
chapters.
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Hardware
The first Arduino was introduced in 2005.  Since then it has become extremely
popular with hobbyists all over the world.  The main reason being its ease of
use, price and support.  The simplest  one is  the Arduino Uno.  We will  be
using  the  Arduino  MKR1000 [2],  which  has  a  few  very  nice  additional
features.  Besides those, there are many other Arduinos available.

MKR1000 Board Specifications
The MKR1000 has the following features:

• regular USB (5V) can act as power supply (VIN), 
• operating voltage is 3.3V, 
• it has 8 digital I/O pins, 
• it has 12 PWM pins (0,1,2,3,4,5,6,7,8,10,A3 or 18,A4 or 19), 
• it has 7 analog input pins (ADC 8/10/12 bit), 
• it has one analog output pin (DAC 10 bit), 
• the build in LED is at pin 6, and
• it supports Wi-Fi .

Its CPU is a 32-bit ARM CPU running at 48 MHz.  It has 32 KB of SRAM and 256 KB of flash memory.

To keep our Arduino healthy, we need to be aware of two things: the voltage applied to any pins should
always be less than 3.3V and the current we draw from any of the I/O pins must be less than 7 mA. If we
keep these limits, than our Arduino will be fine.  If not, it will be dead.

A very good reference into the foundations of Arduino hardware and software is reference [4].   It is a very
good idea to printout reference [3], the pinout of the MKR1000.

Software and IDE
To program the Arduino, we need a computer.  That can
be  a  Windows  PC,  Mac  or  Linux computer.  All  the
computer  needs  is  a  USB  port.  Arduino  comes  with
software to program it, the Arduino IDE [3].  It is very
easy to install and use.  Basically, the Arduino uses the
C programming language, but to us it will almost look
like Java.

Any Arduino program starts in the setup() method.  This
method is called only once, at the start of the program.  

void setup() {
  // executed only once at start
}

void loop() {
  // executed repeatedly

}

After the setup, the loop() method is called.  It is called
again and again, until you turn of the Arduino or upload
a new program.
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Before you can run your programs, you need to compile them.  This is done either through the menu
(Sketch->Verify/Compile), a shortcut (Ctrl-R) or a button.  If the compiler is happy with your code, you
can upload it to your Arduino.  This can be done through the menu (Sketch->Upload), a shortcut (Ctrl-U)
or a  button.  Once a program is uploaded to the Arduino, it will start executing immediately.  You can
only run one program at a time. 

The IDE comes with really many examples, you can find them under File->Examples.

Serial
The Arduino board can send messages to our PC via the serial port.  With serial port we mean the USB
port.  For this you need to setup a serial connection in the setup() method,

void setup() {
  Serial.begin(9600);
}

void loop() {
  Serial.println("Hello from your Arduino");
  delay(1000);

}

Then use the Serial.println() method to print to the Serial Monitor.  The Serial Monitor (Ctrl-Shift-M) is
part of the IDE.  It shows us the messages that come from the Arduino board.

The communication is two way, meaning we can also send messages from the Serial Monitor to the
Arduino. Again, we need to setup a serial connection in the setup() method,

void setup() {
  Serial.begin(9600);
}

void loop() {
  if (Serial.available() > 0) {
    char c = Serial.read();
    Serial.println(c);
  }

}

Then in the loop() method, we wait for incoming characters.  If one is available, we can read it.  We can
only read one character at a time.  Strings are quite different in C as compared to Java [5].

Digital I/O
Our Arduino has a whole bunch of digital pins (0,1,2,3,4,5,6,7,8,10)  We can write to and read from
them.  First, we must specify, if we want to use a pin as input or output pin.   We do this in the setup using
the pinMode() method.  We specify the pin (here it is pin 6) and whether to use it as INPUT or OUTPUT:

int ledPin = 6;

void setup() {
  pinMode(ledPin, OUTPUT);
}
void loop() {
  digitalWrite(ledPin, HIGH);
  delay(1500);
  digitalWrite(ledPin, LOW);
  delay(500);

}
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Once we specified that, we can use the digitalWrite() method to write to that pin.  A digital pin can have
two states,  either  LOW, which is  0  volts,  or  HIGH, which for  our Arduino is  3.3 volts.   Interesting
enough, there is an internal LED connected to pin 6, so when running the above program that LED should
blink.

Reading works completely analogous.  You must  declare  the  pin as  INPUT pin using the pinMode()
method,

int ledPin = 6;
int inPin = 0;

void setup() {
  pinMode(ledPin, OUTPUT);
  pinMode(inPin, INPUT);
}

void loop() {
  int val = digitalRead(inPin);
  digitalWrite(ledPin, val);

}

and then use the digitalRead() method to read from that pin.

Analog I/O
In addition to digital  I/O, there is  also analog I/O.  All  Arduinos can read analog  voltages using the
analogRead() method.  Again, we first need to say that we want to use a pin as INPUT or OUPUT.  Then
we need to specify the resolution of the converter,  using the  analogReadResolution() method. Here 8
stands for 8-bit, resulting in values between 0 and 255.  We can also use 10-bit or 12-bit resolutions.

void setup() {
  Serial.begin(9600);
  pinMode(A1, INPUT);
  analogReadResolution(8);
}

void loop() {
  Serial.println( analogRead(A1) );
  delay(2);

}

You can see the readings either in the Serial Monitor, or if it is numbers, then you can also use the Serial
Plotter (Ctrl-Shift-L), to visualize the data in a graph.  Arduino uses an analog to digital converter, also
called ADC, to do the conversion from input voltages to digital numbers.  Our Arduino has seven analog
input pins (A0-A6).  The two millisecond delay gives the ADC a little time.  It is not the fastest.

Some Arduinos also have analog output pins.  Our Arduino (MKR1000) has one, the DAC0 pin.  On that
pin we can create arbitrary output  voltages, between 0 and 3.3 volts in our case.  To do this, it uses a
digital to analog converter, called DAC.  It is on pin A0 for the  MKR1000.  We do need to specify its
resolution, which for the MKR1000 can only be 8-bit or 10-bit.  However, for some strange reason, we
should not set the pin as output pin, but rather not specify it at all.
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int val = 0;

void setup() {
  Serial.begin(9600);
  pinMode(A1, INPUT);
  analogReadResolution(8);
  // do not do this: pinMode(A0, OUTPUT);
  analogWriteResolution(8);
}

void loop() {
  val += 1;
  val %= 256;
  analogWrite(A0, val);
  Serial.println(analogRead(A1));
  delay(2);

}

This means, we can actually use our Arduino to generate arbitrary wave forms, i.e. become a function
generator.

PWM
Another form of analog output is Pulse Width Modulation (PWM).  In PWM
we do not modulate the voltage.  The voltage is either 0 or 3.3 volts.  But we
generate a square wave, where we modulate the width of the pulse.  If you
average that, it then looks almost like an analog voltage.  PWM is available
on all Arduinos, even if they do not have a DAC. 

int val = 0;

void setup() {
  Serial.begin(9600);
  pinMode(A2, OUTPUT);
}

void loop() {
  val += 1;
  val %= 256;
  analogWrite(A2, val);
  delay(2);

}

The value can be any value between 0 and 255.
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Review
In this chapter we introduced the Arduino physical computing platform.  Among the many different kinds
of Arduinos, we focused on the MKR1000, mostly because it comes in such a beautiful box.  We had a
brief introduction to the Arduino IDE and how to write simple Arduino software sketches with it.   In the
ensuing examples we saw how to communicate between Arduino and PC, how to use the digital and
analog inputs and outputs, and what PWM stands for.  We have now enough knowledge under our belts to
become really dangerous!

Labs
Today we will use our Arduino for the first time.  We will learn how to connect it to our laptop, install the
required software, upload and execute programs on the Arduino, and how to connect different electronic
components such as  diodes,  LEDs and  transistors to it.  Many of the examples here are inspired from
Programming in Arduino [3].

Before you can start with any of the experiments in this chapter, you need to install the Arduino IDE first,
see the appendix for details.

Preparations
Before attempting to perform any of the experiments in this lab, you need to have done the following
preparations beforehand.  You have to be able to

• bring your laptop, and ideally have installed the Arduino IDE on it [6], 
• you have read the Arduino MKR1000 FAQ [7], 
• know about static electricity, and 
• why you should not connect the Arduino directly to your laptop, but always connect it using a

USB hub. 

Note to Instructors
Equipment: Arduino box, bipolar transistor BC547.

Before you Start
Equipment: Arduino box.

Although quite robust, the Arduino has to be handled carefully.  Try to avoid
any static electricty.  When not needed, put the Arduino back on its conductive
foam and inside its anti-static bag.  The image on the side shows the Arduino
on its conductive foam (black).

Before using the Arduino, remove the conductive foam that protects the pins
and place it on the breadboard.  Do this very carefully, and make sure not to bend any of its legs.  If you
have difficulty, ask your instructor to help you.

Connect the Arduino through the USB hub with your computer.  There has been irreparable damage to
laptops, so to avoid that use a hub.

The Arduino is powered through the USB hub.  So before building circuits, disconnect your Arduino from
the USB hub.  Before connecting it, please let an instructor check your circuit. 
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Make sure you understand the different voltages on the Arduino board, Vin, 5V and VCC:

• Vin: This pin can be used to  power the board with a 5 volts  source.  WE WILL NOT USE
THIS. 

• 5V: This pin outputs 5 volts  powered from the USB connector.  WE SHOULD NEVER USE
THIS. 

• VCC: This pin outputs 3.3V through the on-board voltage regulator. 

You should always use  VCC, i.e., the 3.3 volts.  Connecting any of the pins to 5 volts (or more) will
destroy your Ardunio.  Not a good thing.

Preparing the IDE
Equipment: Laptop, Arduino box.

After  installation  of  the  IDE,  you  need  to
select  the  proper  Arduino  board.  There  are
many Arduinos, we are using the  MKR1000. 
So  under  Tools->Board  select  the  proper
board. 

Also make sure you selected the correct serial
or USB port your Arduino is connected to.  On
Mac and Linux everything should work out of
the box.  On Windows you most likely have to
install a driver, follow the instructions in [9].

1. Blink
Getting the LED "L" to  blink is actually quite easy:  simply type the following
code  into  the  Arduino  Software  (or  load  the  "Blink"  scetch  from
File>Examples>Basics).  Verify it (Ctrl-R) and Upload it (Ctrl-U) to the Arduino
board.  The LED should start blinking [10].

int ledPin = 6;

void setup() {
  pinMode(ledPin, OUTPUT);
}

void loop() {
  digitalWrite(ledPin, HIGH);
  delay(1500);
  digitalWrite(ledPin, LOW);
  delay(500);

}
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2. Blink and Serial
In this scetch we learn how the Arduino board can send messages to our
PC via the USB serial port. 

int ledPin = 6;

void setup() {
  Serial.begin(9600);
  pinMode(ledPin, OUTPUT);
}

void loop() {
  digitalWrite(ledPin, HIGH);
  Serial.println("LED is ON");
  delay(1500);
  digitalWrite(ledPin, LOW);
  Serial.println("LED is OFF");
  delay(500);

}

The LED should blink again, but if we look at the Serial Monitor (Ctrl-Shift-M), we see messages that
come from the Arduino board.

3. Serial-2-Way
We can also use the Serial Monitor to send commands or strings to the
Arduino via the serial port.

int ledPin = 6;

void setup() {
  Serial.begin(9600);
  pinMode(ledPin, OUTPUT);
  Serial.println("Greetings from your
Arduino!");
}

void loop() {
  if (Serial.available() > 0) {
    char incomingMessage = Serial.read();
    if (incomingMessage == 'H') {
      digitalWrite(ledPin, HIGH);
    } else if (incomingMessage == 'L') {
      digitalWrite(ledPin, LOW);
    }
  }

}

Run the above program, open the Serial Monitor, type an 'H' in the text  field, and click on the "Send"
button.  The LED on the Arduino should turn on.  If you send the 'L' command, the LED should switch
off.
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4. Button and Tilt Switch
To read the state of a button we use the digitalRead() method.  We connect the
button to the digital pin 2.

void setup() {
  Serial.begin(9600);
  pinMode(2, INPUT);
}

void loop() {
  int switchState = digitalRead(2);
  if (switchState == LOW) {
    Serial.println("Button is OFF");
  } else {
    Serial.println("Button is ON");
  }
  delay(500);

}

The program checks the value of the digital pin 2, and prints the state of the button to the Serial Monitor
(Ctrl-Shift-M).  

Instead of the button, you may also use the tilt switch that comes with the Arduino box.

You can also modify the program such that the LED on the board goes on, if the button is pressed and off
otherwise [11,12].

5. Potentiometer
Next,  let  us read analog input  from the analog pin A1.  For this we need to
connect a potentiometer to the Arduino in the way shown to the right.

void setup() {
  Serial.begin(9600);
  pinMode(A1, INPUT);
  analogReadResolution(8);
}

void loop() {
  Serial.println(analogRead(A1));
  delay(2);

}

To visualize the data being read, we can use the Serial Plotter (Ctrl-Shift-L).  The method analogRead()
converts the voltage applied to pin A1 to a value between 0 and 1023 [14,15].

6. LDR
A photo  sensor or light  dependend  resistors (LDR) will  change its  resistance
depending on the amount of incident light. 

void setup() {
  Serial.begin(9600);
  pinMode(A1, INPUT);
}
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void loop() {
 int sensorValue = analogRead(A1);
 delay(5);
 Serial.print("Raw Sensor Value \t .");
 Serial.print(sensorValue);

}

Here we also see, how to output sensor values to the Serial Monitor in a nice looking way [16,17].

7. Temperature
We can use the analog input  together  with out  temperature sensor to  measure
temperature [18,19].

void setup() {
  Serial.begin(9600);
  pinMode(A1, INPUT);
}

void loop() {
  int sensorVal = analogRead(A1);
  delay(5);
  Serial.print("Raw Sensor Value: ");
  Serial.print(sensorVal);

  // convert raw ADC value to voltage
  float voltage = (sensorVal / 1024.0) * 3.3;
  Serial.print(", Volts: ");
  Serial.print(voltage);

  // sensor changes 10 mV per degree C
  // the datasheet says
  // temp = ((voltage - 500mV) times 100)
  Serial.print(", Degrees C: ");
  float temperature = (voltage - 0.5) * 100;
  Serial.println(temperature);

}

8. PWM
We can use Pulse Width Modulation to change the brightness of an LED. 

const int greenLEDPin = 2;
int greenValue = 0;

void setup() {
  pinMode(greenLEDPin, OUTPUT);
}

void loop() {
  greenValue++;
  greenValue %= 256;
  analogWrite(greenLEDPin, greenValue);
  delay(20);

}

The green LED should get brighter until its brightness goes down to zero.  The period should be about 5
seconds [13].
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9. Melody
To see an example where we use the digital pin as output, look at the
built-In axamples 02.Digital > toneMelody.  You first need to connect
an 8-ohm speaker (buzzer) to GND and digital pin 2.

#include "pitches.h"

const int tonePin = 2;

int melody[] = {
  NOTE_C4, NOTE_G3, NOTE_G3, NOTE_A3, NOTE_G3,
0, NOTE_B3, NOTE_C4
};

// note durations: 4 = quarter note, 8 = eighth note, etc.:
int noteDurations[] = {
  4, 8, 8, 4, 4, 4, 4, 4
};

void setup() {
  // iterate over the notes of the melody:
  for (int thisNote = 0; thisNote < 8; thisNote++) {

    // to calculate the note duration, take one second divided by the 
note type.
    //e.g. quarter note = 1000 / 4, eighth note = 1000/8, etc.
    int noteDuration = 1000 / noteDurations[thisNote];
    tone(tonePin, melody[thisNote], noteDuration);

    // to distinguish the notes, set a minimum time between them.
    // the note's duration + 30% seems to work well:
    int pauseBetweenNotes = noteDuration * 1.30;
    delay(pauseBetweenNotes);
    // stop the tone playing:
    noTone(tonePin);
  }
}

void loop() {
  // no need to repeat the melody.

}

This example also teaches how to use arrays with the Arduino.  Try adding a capacitor between the D2
output of the Arduino and the input of the speaker [20-22].

10. ServoMotor
As an example for an actuator, let us consider the ServoMotor example. 
You need to  connect  the  servo in the  way indicated to  the right.  The
orange cable (yellow in the diagram) should be connected to digital pin 2. 
The brown cable should be connected to GND, the red cable to +3.3V. 

Executing the following code, will result in the servo turning slowly form
0 to 180 degrees.
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#include <Servo.h>

Servo myServo;

void setup() {
  myServo.attach(2); // attach servo to pin 2
  Serial.begin(9600);
}

void loop() {
  for (int angle = 0; angle < 180; angle++) {
    Serial.println(angle);
    myServo.write(angle);
    delay(15);
  }

}

If you open the Serial Monitor, you can see the  current angle the  servo is set to.  This example also
teaches how to import libraries and how to use an object [23].

Challenges

1. Motor
Running a motor requires a little more current than our Arduino
can deliver.  We have to use a transistor.  To the right you see the
circuit using a bipolar transistor.

const int motorPin = 8;

void setup() {
  Serial.begin(9600);
  pinMode(motorPin, OUTPUT);
}

void loop() {
  if (Serial.available() > 0) {
    char incomingMessage = Serial.read();
    if (incomingMessage == 'H') {
      digitalWrite(motorPin, HIGH);
    } else if (incomingMessage == 'L') {
      digitalWrite(motorPin, LOW);
    }
  }

}

You can use the Serial Monitor to turn the motor on and off.

NOTE: BE VERY CAREFUL WHEN BUILDING THIS CIRCUIT.  IT IS VERY LIKELY THAT
YOUR ARDUINO WILL BE DEAD IF YOU GET SOMETHING WRONG!
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We can also use a FET.  The tricky part here is, that for the
FET to switch, it needs a little more than 4 volts.  But our
Arduino only gives  3.3 volts.  So what  do we do?  One
solution is to use another bipolar transistor [26], but that is
kind of stupid, because then we can drive the  motor with
the bipolar, no need for the FET.

But  we  can  use  a  voltage divider  and  do  a  little  level
shifting!  If you look at the schematic to the right, we use
the 4.7kOhm and 1kOhm resistors as a voltage divider.  We
then  connect  the  middle  of  that  divider  to  the  ground
(GND) pin of the Arduino.  That has the effect, that the 1.6
volts of the voltage divider is added to the 3.3 volts of the
Arduino pin, hence shifting us above the 4 volts needed to
switch the FET [24-28]. 

Idea: we may want to improve this circuit using a diode and/or a capacitor.

2. Function Generator
Using the analog output pin A0 and the DAC, we can write a little function generator that might come in
handy when investigating AC voltages and currents.

const int step = 10;
int outputValue = 0;

void setup() {
  Serial.begin(9600);
  // do not do this: pinMode(A0, OUTPUT);
  analogWriteResolution(8);
}

void loop() {
  outputValue += step;
  outputValue %= 256;
  analogWrite(A0, outputValue);

  Serial.print("X: "); Serial.print(outputValue); Serial.print("  ");
  Serial.println("uT");

  delay(10);  // 256 ms = 1/4 Hz

}

Use a real oscilloscope, connect it to GND and pin A0 to see the output.  Change the frequency and the
waveform generated.

We can also generate sound this way, we just need to make sure it generates frequencies in the audible
spectrum.  And we may need to amplify them with a transistor and a 9 volt battery [29-30].

3. Software Oscilloscope
Experiment 5, the  potentiometer can also be used as a software oscilloscope.  Try to estimate its time
resolution.  Use one Arduino as a function generator, and another as a software oscilloscope.
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4. Pressure Sensor
Just to get you thinking, take a look at reference [31].  It basically describes how to turn the anti-static
foam that protects your Arduino from static electricity into a pressure sensor [32,33].

5. LCD Display
If you are interested in using the LCD display that comes with the Arduino box, check out reference [34].

6. Other Projects
Now you basically know how the Arduino works.  There are many cool projects you can do at this stage
[35].  However, you should be aware of the fact, that most projects on the internet assume your Arduino
uses 5 volts.  Since ours does not, you should first learn about level shifting [36].  Also, there are many
sensor kits, with easy to use sensors, check out references [37-39].  And once in a while there are other
projects you find on the internet [40].

Questions
1. What does a digital-to-analog converter (DAC) do?

  
2. Normally the input pins of an Arduino can be connected to 5 volts. Applies this also for the 

MKR1000, the Arduino we used? 
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A. Hardware
We use the Arduino MKR IoT Bundle [1], mostly because it comes in such a beautiful box.  In case you
are not familiar with the different electronic components, I took some photos for you:

Battery Switch Tilt Sensor Bread Board

Resistor Potentiometer Capacitor Inductor

Diode LED Zener

Bipolar Transistor FET Temperature Sensor Photoresistor

Piezo Buzzer Motor Servo Motor

In addition, we add a few components to the kits:

• 9 volt battery 
• copper wire, iron nails 
• alligator clips 
• graphite  pencil  lead,  2x0.5  and 1x0.7mm

(must be real graphite, kind of hard to get) 
• jumper cable 

• potentiometers (ones included are no good)
• Zener diode 
• inductor 
• BC547 (box  includes  2  FETs,  but  they

switch at 4 volts, not at 3.3 volts) 
• hub (to protect your laptop) 
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You will also need a multi-meter, ideally one that can measure  capacitance and inductance.  It should
have a replaceable fuse, because there is a high likelihood, that it gets blown at least once per semester.

The instructor also needs in addition:

• balloons 
• PVC pipe and towel 
• electroscope 
• Leyden jar 
• saran wrap and aluminum foil 
• lemon 
• coil and nails 
• a piece of real silicon 
• a small solar cell 

Hope I did not forget anything.

Arduino MKR IoT Bundle
Currently the "Arduino MKR IoT Bundle" [1] is sold out.  In case that stays that way (likely because of
the FET issue), here is a list of the ingredients of that bundle:

• 1 Arduino MKR1000 board, with header soldered. 
• 1 micro USB cable, 
• 1 400-point breadboard, 
• 70 solid-core jumper wires, 
• 1 9V battery snap, 
• 1 stranded jumper wire 
• 1 stranded jumper wire, 
• 6 phototransistors, 
• 3 potentiometers (10 kilohm), 
• 10 pushbuttons, 
• 1 temperature sensor (TMP36), 
• 1 tilt sensor, 
• 1 alphanumeric LCD (16 x 2 characters), 
• 1 bright white, 
• 34 LEDs (6 ldr bright white, 1 RGB, 8 red, 8 green, 8 yellow, 3 blue), 
• 1 small DC motor (6/9V), 
• 1 small servo motor, 
• 1 piezo capsule (PKM17EPP-4001-B0), 
• 1 H-bridge motor driver (L293D), 
• 1 octocouplers (4NE5), 
• 2 MOSFET transistors (IRF520), 
• 5 capacitors (100uF), 
• 5 diodes (1N4007), 
• 3 transparent gels (R,G,B) 
• 1 male pin strip (40 x 1), 
• 20 resistors (220 ohm), 
• 5 resistors (560 ohm), 
• 5 resistors (1 kilohm), 
• 5 resistors (4.7 kilohm), 
• 20 resistors (10 kilohm), 
• 5 resistors (1 megohm), 
• 5 resistors (10 megohm) 

References
[1] Arduino MKR IoT Bundle, https://store.arduino.cc/arduino-mkr-iot-bundle
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B. Multi-meter
In our experiments we will need to measure resistance, capacitance, voltage, and current. 
We will be using a digital multi-meter for this.  Here we describe how to use a multi-
meter, and what setup is required for each of the different measurements.  Multi-meter
come in all kinds of forms: analog and digital, cheap and expensive, but their usage is all
very similar.  If you know how to use one, you know how to use all of them.

Digitial Multi-meter
If we look at any digital multi-meter, two things are noticeable immediately: the display
with big digits and the round dial with all kinds of different settings.  In addition there are
two cables, one black and one red, with pointed ends, the multi-meters test leads.   Most
multi-meters have a fuse, that protects them in case they are used in the wrong way. 
Hence, when your multi-meter doesn't seem to work anymore, don't throw it away: most of the time, all
you need to do is replace the fuse, which costs only a couple of cents.

Also, most multi-meters have only one way to connect the black cable, but there are several plugs for the
red cable.  You want to avoid the plugs that say "A" or "mA" (for ampere, that is  current) on them,
because those are the ones that cause trouble (more below).  Hence, it is a good habit, if not sure, to
connect the plug that says volts or ohms.

Another thing to notice, especially with our multi-meter, that by default it tries to measure AC.  But we
are only doing DC.  So, if you measure the voltage of a 1.5 volt battery, and it does not read around 1.5
volts, but something more like 0, then it is not because your multi-meter is broken, but because you have
it in the AC setting.  Simply switch it to the DC setting by pressing the DC/AC button.

Resistance
Measuring resistance is the easiest:  first, you need to turn on the multi-meter, most of the
time by simply turning the dial.  Second, you set the dial to the resistance setting, usually
indicated by an Omega for Ohm.  Here you start with the highest possible setting, usually
some mega-ohm, like 100MOhm.  Then you take the two pointed leads and connect them
to the resistor you want to measure.  Make sure the resistor is not connected to anything
else.  This is very important. 

Let's say the resistor you want to measure is some kilo-ohms.  Then if you measure it with the mega-ohm
setting we selected first, it will read all zeros.  Because compared to mega-ohms, kilo-ohms is basically
nothing.  So what you do then, you gradually adjust the dial, wait a little for the reading to stabilize, and
continue this process until your reading starts to make sense.  Now if you have something that has no
resistance, either because it has none (like a wire or a superconductor), or because it has a short circuit,
then continuing this process to the lowest setting of your device, it will always read zero.   If it does that,
then you know you have a short circuit.
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B. Multi-meter

Short Circuit
We can measure the resistance of just one component, like a resistor, or we can measure the resistance of
a whole circuit.  So before we connect the battery to our circuit, we can connect our multi-meter instead
of the  battery.  If the  resistance we measure is zero, then our circuit contains a  short.  That means our
circuit is a short circuit, and we should not connect the battery.  Instead we should find the short, fix it,
make sure it is fixed, by again measuring the resistance of the whole circuit.  Only after being certain that
we do not have a short, should we connect the battery!

Capacitance
Measuring  capacitance is completely analogous to  resistance.  You set your multi-meter to the highest
capacitance setting it has, usually indicated by a C for capacitance or something like nF for nano-Farad,
or uF for micro-Farad.  Again start with the highest setting.  Then connect the  capacitor to your multi-
meter. 

A couple  of  remarks on measuring  capacitance:  first,  not  all  multi-meters  can measure  capacitance. 
Actually most of the cheaper ones, can not measure capacitance.  Second, when measuring capacitance,
you should do this only for the small  capacitors that we have.  Large  capacitors (like the ones inside
washing machines) are very dangerous.  Quite often they might still be charged, and a shock from a large
capacitor, that was connected to 220 volts, and still holds some rest-charge, could be lethal!

Voltage
Measuring  voltage is  a  little  more  complicated:  you measure  voltage while  your
circuit  is  connected  to  the  battery,  that  is  on  a  "live"  circuit.  When  measuring
anything on a live circuit, one has to be quite careful not to accidentally cause a short
circuit.  So make sure you only touch the pieces you intend to touch!  The diagram on
the side depicts how you measure voltage.

First, you select whether you want to measure DC or AC type voltage.  We will only measure DC, hence
select the DC setting.  Second, pick the voltage setting that is slightly higher then your batteries voltage. 
So if you have a 9 volt battery, select the 10V or 20V setting on your multi-meter.  Finally, connect the
black lead first, usually on the side of the resistor that is connected to the negative pole of the battery, and
then connect the red lead to the other side of the resistor, usually the one that is connected to the positive
pole of the battery.  If you happen to switch the poles, you will get a negative reading for the voltage. 
That is fine.
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B. Multi-meter

Current
Measuring  current is the most complicated, and should be done with care.  Many multi-
meter (or better fuses) have not survived a wrong current measurement!  The reason being,
when measuring current, actually current is flowing through your multi-meter, and to much
current is just deadly for anything.  But that is what fuses are for: in your multi-meter, they
protect the multi-meter, in your house, they protect you. 

For most  multi-meters,  you will  have to not  only change the dial  setting to  measuring
current (A), but you also have to reconnect the red (positive) lead to a different output
terminal.  Most multi-meters actually have two different ones: one for lots of current, like
10 amperes (10A), and one for smaller  currents like milli-amperes (mA).  We only work
with batteries, so the milli-ampere setting is what we want.  Again, we start with the highest
values our multi-meter allows for, maybe something like 500mA.  And we need to tell it, if
we intend to measure DC or AC: we will only measure DC, hence select the DC setting.

Next, we connect the multi-meter to our circuit.  If you look at the circuit for measuring current on the
side, you will notice, that the multi-meter is part of the circuit.  So we kind of have to "break" our circuit:
we need to find a spot where we can integrate our multi-meter into the circuit.   The easiest way to do this,
simply remove one of the connecting wires, and replace it by the multi-meter. 

Transistors
Some modern digital multi-meters actually allow for the checking of  transistors and  diodes.  They can
check, if the transistor is still working, if it is a npn- or pnp-type, and usually can measure the transistors
hFE value.  For the details on how to do this, you should check your multi-meters manual.

Inductance
Measuring inductance is  exactly like measuring  resistance or  capacitance.  However,  only few multi-
meters can measure inductance.

References
[1] multi-meter, https://en.wikipedia.org/wiki/multi-meter
[2] Multi-meters current, isaac.exploratorium.edu/~pauld/summer_institute/summer_day15  current  /  
meters_  current  .html  
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C. Simulator
We will be using the Circuit Simulator, developed by Paul Falstad [1], who graciously put this incredible
project under an open source license.  The Simulator can be integrated in web pages, but there is also a
desktop version available.

Overview
Since  it  runs  in  a  browser,  no  installation  is
necessary.  Using  the  File menu you can import
and  export  circuit  files.  They  are  basically  text
files  describing  the  circuit.  Under  the  Circuits
menu you will find quite an incredible number of
example circuits.  Additional ones can be found on
the website [2].  The examples from the lectures
are  to  be  found  in  the  file  "pc_004.zip"  on  the
Google drive.

Finally, if you want to modify existing circuits or
create  your  own  from  scratch,  you  find  all
available  electronic  components  in  the  Draw
menu.  You  simply  select  which  component  you
want to use, and click somewhere on the diagram
to place it.  You can then drag it around, change its size and direction and add it to the circuit as you like.
By clicking on the "Run/Stop" button you can then start the simulation.

Get Started
To get started, it is probably a good idea to start simple.  For this draw a battery ('v'), then a
resistor ('r'), a switch ('s') and a lamp (), and connect them with wires ('w').  If you want a real
lamp, instead of an LED, you find that under the Draw menu (Outputs and Labels > Add
Lamp).  Now test your first circuit by turning the switch on and off. 
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C. Simulator

Circuit Diagrams
Below are all the circuit diagrams that we will be needing:

Of Interest
As you will see, the Circuit Simulator is pretty amazing.  Towards to end of the class we will need the fact
that it is possible to create and use sub-circuits [3].  Also, helpful might be the fact that one can import
circuits through the URL:

http://falstad.com/circuit/circuitjs.html?cct=
$
+1+0.000005+10.20027730826997+53+5+50%0Aw+304+64+304+128+0%0Ad+304+128+36
8+192+2+
default%0Ad+304+256+368+192+2+default%0Ad+240+192+304+128+2+default
%0Ad+240+192+304+256+2+
default
%0Aw+304+256+304+352+0%0Aw+368+192+416+192+0%0A207+304+64+304+16+4+
+in%5Cp%0A207+304+352+304+400+4++in-%0A207+416+192+480+192+4+

+out%5Cp%0A207+240+192+160+192+4++out-%0A

References
[1] Circuit Simulator, http://falstad.com/circuit/
[2] Electronics Demonstrations, falstad.com/circuit-java/e-index.html
[3] How to create sub-circuits: http://falstad.com/circuit/subcircuits.html
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D. Arduino IDE
Before we can use our Arduino, we need to install the Arduino IDE on our computer.

Installation of Arduino Software
Depending  on  your  operating  system,  the  installation
may be slightly different.

Linux
• download IDE from Arduino website [1] 
• unzip and install running ./install.sh 
• connect Arduino board through USB 
• you need to add your username to the tty and

dialout groups:
  sudo usermod -a -G tty yourUserName
  sudo usermod -a -G dialout yourUserName 

• logout  and  log  back  in,  for  changes  to  take
effect 

• start  IDE,  make  sure  to  select  your  Arduino
board under Tools>Board 

• select serial port under Tools>Serial Port 
• change language in File>Preferences 
• load  the  "Blink"  scetch  from

File>Examples>Basics 
• run your first scetch 

Mac [4]
• download IDE from Arduino website [1] 
• you may have to unzip the software 
• to install it, copy the Arduino application in the Applications folder 
• connect Arduino board through USB 
• start IDE, make sure to select your Arduino board under Tools>Board 
• select serial port under Tools>Serial Port 
• change language in File>Preferences 
• load the "Blink" scetch from File>Examples>Basics 
• run your first scetch 

Windows
• download IDE from Arduino website [1] 
• install software 
• connect Arduino board through USB 
• install drivers 
• start IDE, make sure to select your Arduino board under Tools>Board 
• select serial port under Tools>Serial Port 
• change language in File>Preferences 
• load the "Blink" scetch from File>Examples>Basics 
• run your first scetch 
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D. Arduino IDE

Shortcuts
The following shortcuts will become handy, when doing a lot of Arduino coding:

• Ctrl-S: Save 
• Ctrl-R: Verify 
• Ctrl-U: Upload 
• Ctrl-T: Pretty Print 

Arduino Board MKR1000
The schematic on the side shows the layout of the Arduino MKR1000.  We see the USB
and  power connectors.  Usually the Arduino gets its  power through the USB port.  In
addition we see two sets of pins: on the right there are pins for  power and for digital
inputs/outputs (D6-D14).  On the left we see the analog output DAC0, the analog inputs
A1-A6, and some more digital inputs and outputs (D0-D5).  There are also a few LEDs:
the power LED, the TX and RX (for communication) and the "L" LED, the one we will
be using a lot.

Test: Blink
Getting the LED "L" to blink is actually quite easy:  simply type the following code into
the Arduino Software (or simply load the "Blink" scetch from File>Examples>Basics). 
Verify it (Ctrl-R) and Upload it (Ctrl-U) to the Arduino board.  The LED should start
blinking.

void setup() {
  pinMode(6, OUTPUT);
}

void loop() {
  digitalWrite(6, HIGH);
  delay(1000);
  digitalWrite(6, LOW);
  delay(1000);

}

(see: https://www.arduino.cc/en/Tutorial/Blink)

References
[1] Download the Arduino IDE, https://www.arduino.cc/en/Main/Software
[2] Arduino Beginner’s Course, http://runtimeprojects.com/2016/03/arduino-beginners-course-
introduction-to-arduino/
[3] ESP8266 Remote Controlled Sockets, http://randomnerdtutorials.com/esp8266-remote-controlled-
sockets/
[4] Install the Arduino Software (IDE) on OS X, https://www.arduino.cc/en/Guide/MacOSX
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E. Definitions
A couple of definitions of terms.  It might come in handy, but personally, I believe the formulas in the 
next appendix are more useful.

Ampere (A): Is the SI unit for current I. It is defined in terms of the charge of an electron via 1 C = 1 A·s.

Capacitor: An electronic component that stores energy in the form of an electric field.  It resists a sudden
change in voltage.

Conductance (S): The inverse of resistance. Measured in Siemens, which are the inverse of Ohms, 
1 S = 1/Ω], then a .

Coulomb (C):  The elementary charge e of the electron is defined to be -1.602 176 634 × 10−19 Coulomb.

Current (I): The movement of charge carriers, usually electrons, in an electric field. It is measured in 
Amperes.

Henry (H): The SI unit for inductance.

Impedance (Ω):): A more generalized form of resistance, also valid for AC type current. The impedance of
a device can vary with the frequency of the electricity applied. A perfect resistor will have a constant 
impedance for all frequencies. Capacitors and inductors have varying impedances at different frequencies.
It is measured in Ohms.

Inductor: An inductor is a device that stores energy in a magnetic field. It opposes a sudden change in the
flow of current.

Joule (J): The work required to exert a force of one newton (1 N) for one meter (1 m), 1 J = 1 N·m.

Ohm (Ω):): A measure of resistance or impedance, 1 Ω], then a  = 1 V/A.

Power (P): Voltage times current, measured in watts. The amount of work being done per unit time.

Resistance (Ω):): Properties of a circuit that impede the flow of electrons. Resistance converts electrical 
energy into phonons that are given off as waste heat. Resistance is measured in Ohms.

Volt (V): A potential due to an electric field. One volt is defined as one joule of work per one coulomb of 
charge, 1 V = 1 J/C.

Voltage: Is the difference in electric potential between two points in an electric field.  It is measured in 
volts.

Watt (W): A measure of power (P). A watt is a joule (1 J) of work done in a second (1 s). 1 W = 1 J/s.
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F. Formulas
It  is helpful to briefly review some formulas from school.  First,  it gets us into the formula mode of
thinking, and second, it might help us to get a better feeling for the electrical units.

Mechanics and Gravity
As a starter, let's remember what we learned in school about mechanics and gravity.

Force
According to Newton, force (F) is defined as mass (m) times acceleration (a):

Now when we talk about gravitation, then the acceleration, a, becomes the Earth's acceleration, which we
call g and Newton formula becomes

where the g is the famous 9.81 [m/s2]. The force is measured in Newtons, [N], and mass is measured in
[kg].

Energy
Energy, or to be more precise, potential energy in a gravitational field, is defined as

Here, W stands for work, and x is the distance that we move something in a gravitational  field.  The
higher we lift something, there more energy is needed.  Energy or work is measured in Joule [J] and
distance is measured in meters [m].

Power
Finally, there is something called power (P) and that is defined as work per unit time, i.e.,

Power is measured in Watts [W] or in the old units horsepower.  It is pretty useless, unless when you buy
a car or a battery, then you want to know.

Electrostatics
After remembering these basic formulas from mechanics, we can see the equivalence in the electrical
world. 

Force
In gravitation, we talked about a gravitational field (g), and a particle of mass (m) will experience a force
(F) by its effect.  Similarly, a charge (q) will experience a force (F) in an electric field (E)
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Now, force is still measured in Newton [N], but charge is measured in Coulomb [C], and the electric field
has units of volt per meter [V/m].

Energy
Energy is still defined as force times distance,

This is electric potential energy, i.e., if we want to move a charge q in an electric field of strength E by a
distance x, then the above equation gives us the energy needed to do that.

Analogy
What  you  hopefully  noticed  was  that  there  is  an  analogy  between  gravitation  and  electricity.  In
gravitation we talk about a mass m, in electricity we talk about a charge q.   In gravitation there is a
gravitational field, g, and in electricity there is an electric field, E.  Gravitational fields exert a force on
masses, and electric  fields exert  forces on charges.  And to move a mass in a gravitational  field costs
energy, and to move a charge in an electric field, also costs energy. 

Voltage, Current and Resistance
Life would have been easy, if the story ended here. But turns out, when we deal with electric circuits, it is
very hard to measure an electric  field, and even harder to measure a charge.  But it is really easy to
measure voltage and current.  That is why the story continues, because we want to measure stuff.

Voltage
The voltage is defined as work done divided by the amount of charge being moved,

Voltage is measured in volts [V] and as above, work in Joule [J] and charge in Coulomb [C].

As you see,  voltage is  like  the  electric  potential  energy (W) per  charge (q).  This  is  why  voltage is
sometimes also called the electric potential.  So voltage has to do with energy.

Current
The current is defined as amount of charge being moved over a given period of time,

Current is measured in ampere [A], charge is still  measured in  Coulomb [C], and time is measure in
seconds [s].

Think of a little piece of wire, and imagine all the little electrons in there as they move.  You count the
number of electrons that move in a short piece of this wire over the time period of one second.  That is
current.
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Power
Remember that power (P) was defined as work per unit time, i.e.,

and using the definitions for voltage and current above, you might see after some math-gymnastics that

Power is still measured in Watt [W], voltage in volts [V] and current in ampere [A].

Resistance
Now there is one last thing missing and that is electrical resistance (R).  It is defined as voltage divided by
current,

Resistance is measured in Ohm [Ω], then a ], voltage in volts [V] and current in ampere [A]. 

As an interesting side note, there is no real mechanical equivalent to the idea of electrical resistance.  It's
something new.  It's Ohm's law.
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